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CHƢƠNG I: LÀM QUEN VỚI OUTLOOK 2010 

1. Làm quen Outlook 2010 

a. Quản lý nhiều tài khoản e-mail từ một nơi 

Bạn có thể dễ dàng quản lý e-mail từ hộp thƣ nhiều. Đồng bộ hóa các loại 

email của nhiều tài khoản e-mail từ các dịch vụ nhƣ Hotmail, Gmail hoặc 

chỉ là về bất kỳ nhà cung cấp khác sang Outlook 2010.  

 

b. Social Networking Integration:  

Microsoft nhận ra xu hƣớng phát triển của mạng xã hội nên đã thêm 

Outlook Social Connector vào ứng dụng Outlook 2010. Outlook Social 

Connector có thể vừa xem mail, vừa cập nhật tình trạng, chia sẻ tập tin 

và hình ảnh. Từ đó giúp duy trì và mở rộng mạng lƣới xã hội của bạn tốt 

hơn. Sẽ xuất hiện Facebook add-in trong những phiên bản đầu. 

Cũng như các phiên bản Outlook trước, người dùng có thể đặt trang 

chủ của mình cho một thư mục. 
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Quản lý lịch từ nay sẽ đơn giản và tốt hơn Outlook 2007, khả năng 

đồng bộ đúng với lịch hiện tại. 

  

 

Bên cạnh khoản chỉnh giao diện người dùng, sẽ có thêm nhiều lựa 

chọn để kết nối tới các dịch vụ bên ngoài, sản phẩm và khách hàng. 

  

 

Học tập phong cách tối giản hết sức từ Windows 7, giao diện làm 

việc Office 2010 đã gọn gàng chứ không còn lộn xộn như trước. 
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Windows Live Mail thật đáng khen, các Ribbon có thể dễ dàng quản 

lý để ẩn, hiển thị hoặc biến mất hoàn toàn. 
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Khi nâng cấp lên phiên bản mới, người dùng chỉ cần thực hiện thông 

qua quá trình cài đặt.  

Thậm chí nếu gỡ bỏ version cũ thì phần setting vẫn được duy trì. 

 

c. Tìm hiểu về Ribbon 

Giao diện mới của Outlook 2010 có tên gọi là Ribbon. Nếu bạn 
đã sử dụng Microsoft Office Word 2010, các giao diện sẽ quen 
thuộc với bạn hơn vì trong Outlook 2010 được soạn thảo dựa 
trên Word 2010, các lệnh trong Word sẽ có sẵn khi bạn soạn 
soạn nội dung trên Outlook. 

Ribbon của outlook 2010 được sắp xếp như sau: 

 

1 Tabs: các giao diện được tạo ra từ các Tab khác nhau. Ở hình 
trên là giao diện của tab Message. Trong các tab là các lệnh và 
các nút lệnh. 

2 Groups: Mỗi Tab có các lệnh liên quan đến nhau, ta có thể 
gom thành một nhóm (group). Ví dụ hình trên là nhóm Basic 
Text. 

3 Trong hộp Font chữ có chứa các kiểu chữ dùng để định dạng 
các kiểu chữ. 
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d. Thanh công cụ mini 

 

Thanh công cụ mini giúp người dùng định dạng văn bản thuận lợi và 
nhanh chóng hơn.  

1 Chọn văn bản của bạn bằng cách kéo chuột để tô khối, sau đó 
Click chuột phải, thì thanh công cụ sẽ hiện ra. 

2  Thanh công cụ sẽ xuất hiện chìm trên nền văn bản. Nếu bạn trỏ 
đến nó, nó sẽ hiện nổi lên và bạn có thể sử dụng nó để định dạng 
văn bản. 

 

e. Calendar- lịch làm việc 

Tính năng Calendar cần thiết cho ai thƣờng xuyên phải sắp xếp thời gian 

gặp khách hàng, hội họp. Ngƣời dùng còn có tùy chọn nhắc lịch làm việc 

theo giờ, theo ngày (dòng nhắc nhở hiện trên màn hình theo lịch hẹn)… 

Thông tin lịch làm việc của từng cá nhân trên thƣ mục dùng chung còn giúp 

ngƣời dùng biết đồng nghiệp khi nào bận công tác, nghỉ ốm… 
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f. Tác dụng của Contacts 

 

 

Bạn có nhiều mối quan hệ, bạn không thể nhớ hết nghề nghiệp, địa 

chỉ … của từng người. Trong Outlook 2010, Contacts có tác dụng 

lưu trữ thông tin của đối tác của bạn, để dễ dàng cho việc tìm kiếm. 

Bạn có thể lưu bất kỳ thông tin của ai trong Contacts. 

2. Các thao tác cơ bản 

a. Dùng nhiều tài khoản Outlook trên một PC 
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Show Profiles 

 

Nhấn nút  Add 
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b. Một số khái niệm: 

Các giao thức gửi và nhận Email 

a. SMTP (từ chữ Simple Mail Transfer Protocol) -- hay là giao thức chuyển 

thƣ đơn giản. Đây là một giao thức lo về việc vận chuyển email giữa các 

máy chủ trên đƣờng trung chuyển đến địa chỉ nhận cũng nhƣ là lo việc 

chuyển thƣ điện tử từ máy khách đến máy chủ. Hầu hết các hệ thống thƣ 

điện tử gửi thƣ qua Internet đều dùng giao thức này. Các mẫu thông tin có 

thể đƣợc lấy ra bởi một email client. Những email client này phải dùng giao 

thức POP hay giao thức IMAP.  

b. IMAP (từ chữ Internet Message Access Protocol) -- hay là giao thức truy 

nhập thông điệp (từ) Internet. Giao thức này cho phép truy nhập và quản lý 

các mẫu thông tin về từ các máy chủ. Với giao thức này ngƣời dùng email 

có thể đọc, tạo ra, thay đổi, hay xoá các ngăn chứa, các mẫu tin đồng thời 
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có thể tìm kiếm các nội dung trong hộp thƣ mà không cần phải tải các thƣ 

về.  

c. Phiên bản mới nhất của IMAP là IMAP4 tƣơng tự nhƣng có nhiều chức 

năng hơn giao thức POP3. IMAP nguyên thuỷ đƣợc phát triển bởi đại học 

Standford năm 1986.  

d. POP (từ chữ Post Office Protocol) -- hay là giao thức phòng thƣ. Giao 

thức này đƣợc dùng để truy tìm các email từ một MTA. Hầu hết các MUA 

đều dùng đến giao thức POP mặc dù một số MTA cũng có thể dùng giao 

thức mới hơn là IMAP.  

Hiện có hai phiên bản của POP. Phiên bản đầu tiên là POP2 đã trở thành 

tiêu chuẩn vào thập niên 80, nó đòi hỏi phải có giao thức SMTP để gửi đi 

các mẫu thông tin. Phiên bản mới hơn POP3 có thể đƣợc dùng mà không 

cần tới SMTP. 

 

 

- Mục Inbox: Là hộp thƣ đến, cho biết số lƣợng thƣ đã gửi đến, khi chọn 

mục này thì khung giữa hiện ra tên, địa chỉ, tiêu đề nội dung,… hộp thƣ của 

ngƣời gửi đến. 

- Mục Drafts: Là mục lƣu các nội dung thƣ đã soạn nhƣng chƣa hoàn chỉnh 

và không gởi đi. 

- Mục Outbox: Là hộp thƣ đi, sẽ lƣu địa chỉ, nội dung thƣ đã gởi đi (chú ý là 

phải có xác lập cho mục này, nếu không sẽ không lƣu). 

- Mục Sent Items: Là mục lƣu các nội dung thƣ đã gởi đi thành công 

- Mục Deleted Items: Các thƣ đã xóa, khi xóa thƣ thì địa chỉ và nội dung 

thƣ đã xóa sẽ chuyển sang mục này chứ chƣa xóa hẳn khỏi mail. Nếu muốn 
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xóa hẳn khỏi mail thì click phải chuột tại mục này và chọn Empty Deleted 

Items.  

- Mục Junk E-mail: lọc các email quảng cáo, Spam hay những thƣ điện tử 

không mời mà đến 

- Mục Outbox: Là hộp thƣ đi, sẽ lƣu địa chỉ, nội dung thƣ đã gởi đi (chú ý là 

phải có xác lập cho mục này, nếu không sẽ không lƣu). 

- Mục RSS Feeds: RSS (Really Simple Syndication) Dịch vụ cung cấp 

thông tin cực kì đơn giản. Dành cho việc phân tán và khai thác nội 

dung thông tin Web từ xa (ví dụ như các tiêu đề, tin tức). Sử dụng 

RSS, các nhà cung cấp nội dung Web có thể dễ dàng tạo và phổ 

biến các nguồn dữ liệu ví dụ như các link tin tức, tiêu đề, và tóm tắt. 

 

Một cách sử dụng nguồn kênh tin RSS được nhiều người ưa thích là 

kết hợp nội dung vào các nhật trình Web (weblogs, hay "blogs"). 

Blogs là những trang web mang tính các nhân và bao gồm các mẩu 

tin và liên kết ngắn, thường xuyên cập nhật. 

c. Gởi email cho nhiều ngƣời nhƣng dấu tên ngƣời nhận 

Thƣ điện tử (email) có 1 điểm ƣu việt so với thƣ thƣờng là ta có thể gởi 1 

thƣ cho rất nhiều ngƣời cùng lúc mà thời gian gởi đi cũng không khác gởi 

cho 1 ngƣời. Thông thƣờng, ta để tất cả địa chỉ email của ngƣời nhận vào 

mục To hay CC nhƣng nhƣ vậy thì những ngƣời nhận thƣ đều thấy toàn bộ 

danh sách ngƣời nhận, khá là bất tiện nếu có ngƣời muốn giấu địa chỉ email 

của mình. Dƣới đây là một cách gởi thƣ cho nhiều địa chỉ nhƣng giấu danh 

sách địa chỉ này không cho ngƣời nhận thƣ xem. 

Một thƣ điện tử thƣờng có các mục: địa chỉ ngƣời nhận (To); chủ đề của 

thƣ (Subject); bản sao đồng gởi thƣờng (Cc - Carbon Copy), bản sao đồng 

gởi bí mật (Bcc - Blind Carbon Copy). Khi bạn gởi thƣ đi, tất cả những gì 

ghi trong mục To, Cc và Subject sẽ đƣợc hiển thị đầy đủ trong e-mail của 

ngƣời nhận. Riêng nội dung trong mục Bcc sẽ không đƣợc hiển thị trong 

thƣ khi nhận. 

Chú ý: khi có nhiều địa chỉ trong các mục To, Cc, Bcc; các địa chỉ phải 

cách nhau bằng dấu chấm phẩy. Không nên gởi cho quá nhiều địa chỉ cùng 

lúc vì các nhà cung cấp dịch vụ sẽ ngăn chặn vì tƣởng là bạn đang gieo rắc 

thƣ rác. Tất cả các dịch vụ Web mail đều cung cấp sẳn tính năng Bcc trong 

cửa sổ soạn thảo email. 

- Trong cửa sổ soạn thảo emai của Outlook, bạn mở menu Options rồi 

chọn View Bcc. 
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d. Đính kèm file vào Email 

Bạn muốn đính kèm file nào đó vào thông báo bạn gửi đi (VD: file 
Word, Exel) bạn làm các bước sau: 

1 Nhập địa chỉ người nhận Email ở hộp TO 

2 Nhập tiêu đề Email ở hộp Subject 

3 Nhấp vào biểu tượng Attach file,  

 

chọn đường dẫn đến nơi lưu trữ file đó, chọn file bạn muốn gửi. 
Nhấn Insert hoặc phím Enter. 
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4 Bạn có thể nhập hoặc không nhập nội dung email muốn gửi, sau 
đó nhấn vào nút Send, Email đã được gửi đi cùng file đính kèm. 
 

 

e. Chèn hình ảnh vào nội dung Email 

- Tạo email mới 

- Chọn Tab Insert, click chọn Picture trong nhóm Illustrations 

 

Chọn một hoặc nhiều hình để chèn vào trong nội dung email 
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f. Chỉnh sửa hình ảnh bạn chèn vào Email 

Để chỉnh sửa hình ảnh bạn làm các bƣớc sau:  

1 Chọn hình ảnh bạn đã đƣa vào trong email.  

2 Bạn sẽ thấy hình ảnh xuất hình trên giao diện và các công cụ xung quanh 

nó.  

3 Bạn dùng các công cụ này để chỉnh sửa hình ảnh theo ý của bạn.  

Bạn cũng có thể sử dụng các công cụ trên với biểu đồ, bản vẽ, sơ đồ hoặc 

tin nhắn. 
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g. Quan sát các file đính kèm trƣớc khi gửi email 

 

 

Trong Outlook 2010s7, khi bạn nhận đƣợc các tài liệu đính kèm ta có thể 

quan sát các file này trƣớc khi mở chúng hoặc lƣu về ổ đĩa. Nó giúp cho 

máy tính của bạn an toàn hơn, tránh lƣu về các mã độc.  

Để xem đƣợc các file này ta nhấn vào biểu tƣợng file đó (nhƣ hình trên). 

Bạn có thể quan sát các file đó ở cửa sổ đọc (cột bên trái Outlook). 

h. Tạo email trả lời tự động (auto reply) 

Khi bạn đi công tác không check mail được, nếu nhận được thư mà 

bạn muốn tự động gửi thư trong Inbox đến một địa chỉ thư định 

trước, trong MS Outlook không hỗ trợ nhưng có thể cài thêm 

chương trình để có chức năng này là Auto Reply 

File >Info > Automatic Replies 
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Hiển thị hộp thoại Automatic Replies > Chọn I am currently Out of the 

Office 

 

Nhập nội dung vào khung “AutoReply only once to each sender with the 

following text”. 

Nếu muốn sử dụng thêm điều kiện để trả lời email tự động chọn vào nút 

Add Rule… 
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Sau cùng nhấn nút OK 

i. Khôi phục các message đã bị xoá trong Outlook 

Cách khôi phục các file bị xoá ở mức lƣu trữ mailbox và trong Public 

Folders trong môi trƣờng Exchange Server.  

 

Chú ý:  

Phƣơng thức này không chỉ đƣợc dùng để phục hồi thƣ hay tin nhắn bị xoá. 

Đây có thể đƣợc coi là một chƣơng trình phục hồi, giảm thời gian khôi phục 

cho các phần tử bị xoá dù không phải là giải pháp sao lƣu hoàn chỉnh. 

Chƣơng trình này có thể đƣợc dùng với các giải pháp sao lƣu Exchange 

Server hoặc thành phần khác nhƣ Recovery Storage Groups (Các nhóm lƣu 

trữ khôi phục), Restore online and offline (Khôi phục trực tuyến và phi trực 

tuyến). 

Hiểu về xoá mềm và xoá cứng trong môi trƣờng Exchange Server  

 

Có hai kiểu xoá dữ liệu trong môi trƣờng Exchange Server: xoá mềm và 

xoá cứng  

 

Xoá mềm: là khi dữ liệu bị xoá bằng phím DELETE và các dữ liệu đó sẽ bị 

chuyển vào thƣ mục Deleted Items.  

 

Xoá cứng: là khi dữ liệu bị xoá hoàn toàn bằng cách ấn tổ hợp phím SHIFT 

+ DELETE và dữ liệu tự động đƣợc loại bỏ khỏi ổ cứng máy.  

 

Các thƣ thƣờng bị xoá cứng trong trƣờng hợp:  

 Ấn tổ hợp phím SHIFT+DELETE trong Microsoft Outlook để xoá 

thƣ.  

 Làm việc trên client Internet Message Access Protocol 4 (IMAP4) 

hoặc client khác không có chế độ tự động chuyển thƣ bị xoá vào thƣ 

mục Deleted Items.  

 Chuyển thƣ sang định dạng file PST.  

Cấu hình Exchange Server  

 

Trƣớc khi nghĩ về khôi phục dữ liệu thì chuẩn bị cách thức duy trì nó 

nhƣ thế nào cũng hết sức quan trọng. Mặc định Exchange Server cho 

phép lƣu lại các thƣ bị xoá trong 7 ngày và tất cả các tài khoản bị xoá 

trong 30 ngày. Bạn có thể tự chỉnh lại thời gian giới hạn nếu thấy cần, 

nhƣng phải đảm bảo có đủ dung lƣợng đĩa trống để lƣu trữ các file đã bị 

xoá cùng với lƣợng ngày tăng lên.  
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Tất cả các thiết lập này ở mức lƣu trữ mailbox, có thể thực hiện theo các 

bƣớc sau:  

 

1. Mở Exchange System Manager  

 

2. Vào Administrative Groups  

 

3. Mở rộng  

 

4. Vào Servers  

 

5. Mở rộng  

 

6. Mở rộng  

 

7. Kích phải chuột lên , chọn Properties > Limits  

 

Hình 1: Các thuộc tính trong Mailbox Store, xác 

định số ngày lƣu các file bị xoá trong hộp lƣu trữ 

mailbox.  

 Thiết lập này đƣợc đặt ở mức lƣu trữ mailbox. Nhƣ thế có nghĩa là 

ngƣời dùng sẽ có 7 ngày để phục hồi các thƣ bị xoá cứng. Nhƣng 

nhiều trƣờng hợp nếu ngƣời dùng là những ngƣời đặc biệt nhƣ các 
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nhà quản lý, các giám đốc công nghệ…, bạn có thể thay đổi giá trị 

thông số nhƣ sau:  

 

Mở Active Directory Users and Computers, kích đúp vào ngƣời 

dùng, chọn tab Exchange General > Storage Limits. Trong hộp thoại 

Storage Limits mở ra (hình 2), chúng ta có thể thay đổi các giá trị 

ngày khác cho từng đối tƣợng ngƣời dùng. (Trong ví dụ này số ngày 

đƣợc đƣa ra cao hơn).  

 

Thay đổi các thiết lập mặc định cho từng ngƣời dùng 

cụ thể 

 

Khôi phục các message đã bị xoá trong Outlook 

Mặc định, tất cả các message đã bị xoá và đƣa vào thƣ mục Deleted Items 

có thể đƣợc phục hồi ở client Outlook (máy của ngƣời dùng). Chƣơng trình 

này đƣợc gọi là xoá mềm. 

Để làm điều đó, bạn vào Tab Folder > "Recover deleted items" 
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Hiển thị hộp thoại "Recover deleted items" 

Trong hộp thoại hiện tất cả các phần tử bị xoá bên trong thƣ mục Deleted 

Items. Bạn sẽ thấy hai lựa chọn: xoá vĩnh viễn các message đƣợc chọn (nút 

thứ ba) hoặc phục hồi chúng (nút thứ hai) trở lại thƣ mục ban đầu (thƣ mục 

Deleted Items). 

 

Mặc định, thành phần trên chỉ làm việc với thƣ mục Deleted Items (xoá 

mềm). Nếu một message bị xoá bằng tổ hợp phím Shift + Delete (xoá cứng) 

từ thƣ mục khác, nó sẽ không xuất hiện trong phần Recover Deleted Items 

của thƣ mục Deleted Items. Một trƣờng hợp phổ biến khác: khi ngƣời dùng 

chuyển các message từ mailbox (Inbox, Sent Items) thành dạng file ".pst", 

các message này cũng không đƣợc lƣu trong thƣ mục xoá tạm thời.  

 

Trong trƣờng hợp đó bạn có thể phục hồi lại bằng cách chỉnh sửa thanh ghi: 

bổ sung thêm thành phần DumpsterAlwaysOn vào thanh ghi máy tính cho 

phép thực hiện khôi phục các phần tử bị xoá (Recover Deleted Items ) trên 

tất cả thƣ mục Outlook.  

 

Để chỉnh sửa thanh ghi, thực hiện theo những bƣớc sau:  

 

1. Vào Start, chọn Run, gõ regedit rồi chọn OK.  

 

2. Vào 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Exchange\Cli

ent\Options  

 

3. Kích phải chuột lên khung bên phải rồi vào New, chọn DWord Value, gõ 

DumpsterAlwaysOn và điền giá trị 1 vào để kết thúc (Hình 5).  
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4. Khởi động lại Outlook.  

 

Bổ sung thêm giá trị DumpsterAlwaysOn  

Sau khi thay đổi lại thanh ghi bạn có thể dùng thành phần Recover Deleted 

Items cho tất cả các thƣ mục Outlook.  

 

Chú ý:  

Khi các message trong hộp Inbox của bạn đƣợc để dƣới dạng file *.pst, 

những message nào đƣợc chuyển đi trong chƣơng trình đều đƣợc coi là xoá 

cứng.  

Một số mẹo khi sử dụng thành phần Recover Deleted Items  

 

Dƣới đây là trả lời cho một số câu hỏi thƣờng đƣợc đặt ra về Recover 

Deleted Items.  

 

Mẹo 1: Có thể khôi phục các phần tử bị xoá cứng trong thư mục có dấu 

cách như thế nào?  

 

Không có khó khăn gì, chỉ cần dùng ký tự "%20" giữa các từ. Dƣới đây là 

một số ví dụ:  

 Một ngƣời Brazin có hộp Inbox gọi là: “Caixa de Entrada” có thể 

phục hồi các phần tử đã bị xoá bằng cách dùng cú pháp sau:  
http:///exchange//Caixa%20de%20Entrada/?cmd=Sh

owDeleted  

Mẹo 2: Những phiên bản nào của Microsoft Outlook có chức năng Recover 

Deleted Items  
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Đó là phiên bản từ Microsoft Outlook 97 trở về sau 

Mẹo 3: Tôi có thể phục hồi các Note và Contact bằng chức năng Recover 

Deleted Items không?  

 

Có, nhƣng bạn sẽ phải dùng Outlook 2000 hoặc phiên bản mới hơn. Nếu 

bạn đang dùng một phiên bản cũ (Outlook 97 hoặc 98) bạn chỉ có thể khôi 

phục đƣợc các phần tử mail.  

 

Các message đã xoá bị đưa ra ngoài nơi lưu trữ tạm thời Keep deleted 

Items trong trường hợp:  

 

Khi các message đã xoá hết thời gian lƣu trữ tạm thời trong Keep deleted 

Items. Bạn nên dùng chức năng Recovery Storage Group để phục hồi lại dữ 

liệu.  

j. Triệu hồi và sửa thƣ…trót gửi với MS Outlook 

Chỉ cần một cú click chuột là bạn đã có thể gửi thông điệp qua 

email đến cho ngƣời khác. Tuy vậy, đôi khi sự nhanh nhạy đó 

lại làm cho bạn phải khổ sở khi đã lỡ tay gửi đi nội dung thƣ 

không mong muốn, gửi nhầm thƣ quan trọng cho ngƣời khác 

mà không thể nào chỉnh sửa hay lấy lại đƣợc. Nhƣng bạn 

không phải lo lắng, MS Outlook sẽ giúp bạn giải quyết khó khăn 

đó trong nháy mắt. 

 

Gọi về lá thƣ trót gửi  

 

Trong MS Outlook, bạn có thể gọi về một lá thư đã (trót) gửi bằng 

một thủ tục rất đơn giản. Trước tiên, cần bấm vào mục Mail,  

Chọn Sent Items. Khung bên phải sẽ liệt kê các lá thư đã gửi đi. 

Bạn bấm kép lên lá thư muốn thu hồi để mở nó lên. Bây giờ, bạn 

hãy vào mục Actions > Recall This Message…  
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Cửa sổ hiện lên cung cấp các tuỳ chọn để bạn thu hồi lá thư đã gửi. 

Tại mục “Are you sure you want to”, bạn đánh dấu chọn “Delete 

unread copies of this message” để hệ thống tự động thu hồi lại lá 

thư kia cho bạn. 

 
 

Tuy nhiên, không phải lá thư nào cũng có thể thu hồi được, vì MS 

Outlook hiện chỉ có khả năng thu hồi các lá thư mà người nhận chưa 

đọc. Vì thế, bạn cũng nên thiết lập để hệ thống báo cho bạn trong 

trường hợp thư đã được thu hồi hay chưa thu hồi, bằng cách đánh 

dấu chọn “Tell me if recall succeeds or fails for each recipient”. 

Cuối cùng, nhấn OK để xác nhận. 

 

Sửa thƣ đã gửi 

 

Đôi khi, bạn viết một lá thư mà sau khi gửi mới nhận ra đã gửi… 

nhầm người hay nhầm nội dung. Những thao tác dưới đây sẽ giúp 

bạn thay đổi nội dung cho lá thư đó: 

 

- Bạn mở lá thư muốn sửa nội dung, rồi vào Action > Resend This 

Message.  
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Sau khi nội dung lá thư hiện ra trong phần cửa sổ biên tập, bạn tha 

hồ chỉnh sửa lại nội dung rồi gửi đi thay thế lá thư cũ trước đó. 

 

Xoá thƣ đã gửi 

 

Bạn muốn xoá lá thư đã gửi lầm cho người khác, hay sửa lại nội 

dung thư đã gửi đi? Chuyện chẳng có gì là khó với MS Outlook! Đầu 

tiên, bạn cũng mở lá thư đã gửi, rồi vào Action > Recall This 

Message…  

 

 

Trong cửa sổ hiện ra, bạn đánh dấu chọn “Delete unread copies 

and replace with a new message” để hệ thống thu hồi lại thư đã 

gửi và thay thế bằng lá thư mới; đánh dấu chọn thêm “Tell me if 

recall succeeds or fail for reach recipient” để nhận thông báo về 

kết quả chỉnh sửa thư đã gửi đi. Cuối cùng, nhấn OK. Ngay sau đó, 

cửa sổ soạn thư sẽ hiện ra và bạn viết lại nội dung mới cho lá thư dã 

gửi đi. Cuối cùng, bấm Send để gửi lại. Lá thư cũ sẽ được thu hồi và 

thay thế bằng lá thư mới. 

 

Huỷ …thƣ 
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Dĩ nhiên, đây không phải là thư rác như bạn có thể hiển lầm. Việc 

huỷ thư sẽ giống một dạng thư điện tử có lệnh huỷ trong nó. Tưởng 

tượng như bạn đặt một “quả bom” hẹn giờ trong thư, và nó sẽ “nổ 

tung” để “phá huỷ” bức thư khi đến thời gian bạn đặt lệnh “gây nổ”. 

 

Sau khi gõ xong nội dung lá thư, bạn nhấn nút Options…; trong 

dòng Delivery opitions, 

 

Bạn đánh dấu chọn Expires after rồi định thời gian huỷ thư – tương 

tự như định thời gian gửi thư trong tương lai vậy.  

 

Chọn xong, bạn nhấn OK để xác nhận và nhấn Send để gửi thư đi. 

Khi đến đúng ngày hẹn, thư sẽ tự huỷ và không còn dấu vết để thu 

hồi. 
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k. Sử dụng nút voting 

Thu hồi đáp từ một nhóm ngƣời là một cái gì đó rất phổ biến trong môi 

trƣờng văn phòng. Cho dù bạn đang cố gắng để yêu cầu loại bánh pizza để 

đặt hàng cho một cuộc họp, hoặc đi bỏ phiếu về ai sẽ bỏ kế tiếp, những gì 

bạn cần là một cuộc thăm dò.  

Những gì bạn có thể không nhận ra đƣợc rằng nếu bạn đang sử dụng 

Outlook 2010 và Exchange tại nơi làm việc, bạn đã có mọi thứ bạn cần để 

gửi ra một cuộc bầu chọn thông qua email.  

 

 Soạn một email mới trong Outlook, chọn tab Options và chọn Use Voting 

Buttons. Ở đây bạn có thể chọn mặc định hoặc tạo ra các câu trả lời của 

riêng bạn cho câu hỏi thăm dò ý kiến.  
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Nếu bạn chọn Custom chỉ cần gõ vào các trả lời bạn muốn xuất hiện trong 

lĩnh vực Sử dụng các nút biểu quyết, cách nhau bằng dấu chấm phẩy.  

 

Bây giờ bạn có các tùy chỉnh liệt kê các câu trả lời. 

 

Khi ngƣời nhận mở email, sẽ có một thông báo tƣ vấn cho họ để đáp ứng 

bằng cách sử dụng nút bình chọn bao gồm các phản ứng tùy chỉnh.  



Phiên bản thử nghiệm – Lưu hành nội bộ - Microsoft Vietnam 

 

34 

 

 

 

Sau khi ngƣời nhận đã có những sự lựa chọn của mình một hộp sẽ bật lên 

xác minh, các cuộc thăm dò phản ứng và tùy chọn để thêm thông tin bổ 

sung trong email.  

 

Khi họ trả lời bạn sẽ có một lá cờ vào email tƣ vấn cho họ có đƣợc trả lời 

các cuộc thăm dò ... tƣơng tự nhƣ một nhận đọc.  

 

Để xem các số tổng cộng của các cuộc thăm dò, bạn có thể mở thƣ gốc 

trong thƣ mục tin nhắn gửi của bạn, và sau đó nhấp vào nút Theo dõi. You'll 
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see a list of totals underneath the ribbon, and then a list below that of all the 

responses. Bạn sẽ thấy một danh sách các số tổng cộng bên dƣới ribbon, và 

sau đó một danh sách dƣới đây là của tất cả các phản ứng.  

 

 

l. Theo dõi e-mail gửi đi 

Đã bao giờ bạn gặp trƣờng hợp này chƣa: bạn có một e-mail quan trọng gửi 

cho một ngƣời bạn, thế nhƣng đợi mãi chẳng thấy hồi âm. Bạn thật sốt ruột 

và nóng lòng muốn biết họ có đọc e-mail của mình chƣa, hay là e-mail 

mình gửi đi đã bị thất lạc, bị máy chủ mail chặn lại rồi… 

 

Nếu bạn dùng chƣơng trình Microsoft Outlook 2002, 2003, 2007, 2010 để 

gửi nhận thƣ và ngƣời bạn của bạn cũng dùng chƣơng trình này thì việc 

theo dõi e-mail gửi đi thật đơn giản vô cùng. Với tính năng Email Tracking 

của Microsoft Outlook, bạn có thể biết đƣợc chính xác ngày giờ e-mail đến 

đƣợc hộp thƣ của bạn mình và ngày giờ ngƣời đó đọc thƣ của mình. 

 

Theo mặc định, tính năng này không có hiệu lực. Để sử dụng nó, bạn vào 

Tab Options. Nhắp chọn 2 checkbox: 

 

 

 

- Request a Delivery Receipt: Nếu bạn đánh dấu vào lựa chọn này, bạn sẽ 

nhận đƣợc một e-mail thông báo ngày, giờ khi mail đến đƣợc hộp thƣ ngƣời 

nhận. Tuy nhiên, nếu mailserver của ngƣời nhận không hỗ trợ tính năng này 

thì cũng đành chịu thua. 

 

- Request a Read Receipt: Nếu bạn đánh dấu vào lựa chọn này, bạn sẽ nhận 
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đƣợc một e-mail khi ngƣời nhận đọc 

 

Cuối cùng, bạn soạn thƣ và gửi đi nhƣ bình thƣờng. 

CHƢƠNG II: CÁC CÔNG CỤ TIỆN ÍCH TRONG OUTLOOK 

1. Tasks – nhiệm vụ, tác vụ 

a. Tạo một nhiệm vụ (công việc cần thực hiện) 

Nhiều ngƣời ít dùng hoặc chƣa biết đến tính năng quản lý công việc (Tasks) 

của MS Outlook: quản lý công việc của chính mình, giao việc cho nhân 

viên và theo dõi đốc thúc nhân viên, biết đƣợc hôm nay, ngày mai, tuần 

tới… phải làm gì, việc gì ƣu tiên, việc gì đã giao mà chƣa xong… Sử dụng 

tính năng này, ngƣời dùng đã học và áp dụng đƣợc 2 kỹ năng “mềm” là 

quản lý và ủy thác công việc. 

Outlook giúp bạn quản lý, nhắc nhỡ các nhiệm vụ mà bạn đã đề ra. 
Để tạo nhiệm vụ bạn thực hiện theo các bước sau: 

1   Nhấp nút Tasks trong Navigation Bar.  

     Danh sách các tác vụ xuất hiện.  
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2   Nhấp text ghi là Type a New Task.  

     Các từ biến mất, và bạn thấy con trỏ (một đường nhấp nháy).  

3   Gõ nhập tên của nhiệm vụ 

     Nhiệm vụ xuất hiện trong khối bên dưới dòng Subject trên Task 
List  

4   Nhấn phím Enter.  

Nhiệm vụ  mới di chuyển xuống Task List với các nhiệm vụ khác 
khác. 

b. Đánh dấu các nhiệm vụ đã hoàn tất  



Phiên bản thử nghiệm – Lưu hành nội bộ - Microsoft Vietnam 

 

38 

 

 

Các nhiệm vụ khi hoàn thành xong bạn có thể xóa nó đi, nhƣng hãy đánh 

dấu những nhiệm vụ đã hoàn thành thay vì xóa nó, nhƣ vậy sẽ hay hơn.  

Để đánh dấu một nhiệm vụ đã hoàn tất, làm theo các bƣớc sau:  

1 Nhấp nút Tasks trong Navigation Pane (hay nhấn Ctrl+4).  

Module Tasks mở.  

2 Nhấp các từ Simple List trong mục Current View của Navigation Pane.  
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3 Nhấp hộp kế bên tên nhiệm vụ mà bạn muốn đánh dấu đã hoàn tất. Hộp 

trong cột thứ hai kể từ bên trái là hộp bạn cần đánh dấu kiểm. Khi đánh dấu 

kiểm vào hộp, tên của nhiệm vụ thay đổi màu và có một đƣờng thẳng xuyên 

qua nó. Nhƣ vậy là bạn đã đánh dấu xong một nhiệm vụ hoàn tất.  
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2. Contact 

a. Tạo một contact (thông tin liên hệ) 

Bạn muốn lƣu lại nhƣng thông tin ngƣời gửi email cho bạn, thì chính 

Outlook là một công cụ tuyệt vời về quản lý danh sách các tên và địa chỉ và 

nó dễ sử dụng nhƣ sổ tay nhỏ của bạn. 

 

 

Để nhập một contact mới, nhấn nút Contacts trong Navigation Pane, sau đó 

nhấp nút New trên thanh công cụ để mở form nhập New Contact. Điền vào 

các chỗ trống trên form và sau đó nhập Save and Close. . 
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b. Tạo Contact từ email đã nhận 

Mở hoặc xem trƣớc e-mail có chứa tên mà bạn muốn thêm vào danh sách 

liên lạc của bạn. 

Nhấp chuột phải vào tên của ngƣời mà bạn muốn, sau đó nhấp Add to 

Contacts. 

Lƣu ý: Trong Outlook, không có tùy chọn để thêm thông tin liên lạc tự 

động vào Danh bạ hoặc sổ địa chỉ khi bạn trả lời cho một contact. 
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c. Tạo Contact Group trong Microsoft Outlook 

Nếu bạn thƣờng xuyên gửi email trong cùng một nhóm của ngƣời nhận, một 

Contact Group có thể là một thực tế tiết kiệm thời gian. Thay vì phải thêm 

mỗi địa chỉ với mỗi ngƣời nhận, bạn có thể chỉ cần thêm các danh sách 

phân phối email của bạn là bạn đã thêm vào tất cả các địa chỉ liên lạc của 

những ngƣời cần gửi chỉ trong một bƣớc 

 

1. Click Tab Home -> chọn New Contact Group. 

 
 

 

2. Tại khung Name: gõ tên Group 
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3. Nhìn lên thanh Ribbon, click chọn Add Members. 

 
 

4. Chọn From Address Book sẽ xuất hiện 
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5. Chọn contact mà bạn muốn add vào group của mìn, contact bạn muốn 

thêm vào sẽ xuất hiện ngay khung Members textbox. 

 

 

6. Sau khi đã chọn xong click OK 

 

 

7. Click Save & Close. 

 
 

8. Bạn muốn gủi mail theo Group. Bấm Ctrl + N, cửa sổ xoạn thử mở ra 

 

9. Để gửi đến ai, các bạn chọn Address book. cửa sổ select name: contacs 

hiện ra, chọn group mà bạn muốn send, click OK 
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10. Kiểm tra lại xem đã gửi mail đến các địa chỉ trong group chƣa 

 

d. Chuyển danh bạ từ Gmail vào MS Outlook 2010 

Bạn đang sử dụng Gmail theo dạng Webmail, nay lại muốn chuyển sang sử 

dụng với Microsoft Outlook 2010 nhƣng không muốn phải nhập thủ công 

từng địa chỉ e-mail vào contact? Cách đơn giản nhất là trích xuất toàn bộ 

contact trong Gmail để đƣa chúng vào Outlook 2010, cách thực hiện nhƣ 

sau: 
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Khởi động trình duyệt Web rồi đăng nhập vào tài khoản Gmail cần trích 

xuất contact. Sau khi đăng nhập vào tài khoản Gmail, bạn nhấn chuột vào 

liên kết Contacts nằm trong khung bên trái. 

 

Trong cửa sổ contact vừa hiện ra, bạn nhấn vào liên kết All Contact để làm 

xuất hiện tất cả các contact hiện có rồi nhấn vào liên kết All ở khung thứ hai 

bên phải để chọn tất cả các contact vừa hiện ra. Tiếp tục, nhấn chuột vào 

liên kết Export. 

 

 

 

Trong cửa sổ Export, bạn đánh dấu chọn vào mục Everyone (All Contacts) 

và mục Outlook CSV format (for importing into Outlook or another 

application). Sau cùng nhấn nút Export rồi đặt tên và chọn nơi lƣu trữ cho 

tập tin CSV sắp tạo (ví dụ contact.CSV). Tập tin này sẽ chứa toàn bộ 

contact hiện có trong tài khoản Gmail. 
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Công việc tiếp theo của bạn là khởi động Outlook 2010 > vào menu File > 

chọn Open >Import.  
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Khi cửa sổ Import and Export Wizard hiện ra, bạn chọn Import from 

another program or file rồi nhấn Next để tiếp tục. 

 

Trong cửa sổ Import a File, bạn chọn Comma Separated Values (DOS) rồi 

nhấn Next để tiếp tục. 
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Trong cửa sổ tiếp theo, bạn nhấn nút Browse trong mục File to import rồi 

chọn tập tin contact.CSV chứa toàn bộ contact đã trích xuất từ Gmail. Đồng 

thời, đánh dấu chọn vào ô Do not import duplicate items để loại bỏ các 

contact trùng lắp. Nhấn Next để tiếp tục. 
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Trong cửa sổ tiếp theo, bạn chọn thƣ mục sẽ dùng để lƣu các contact sắp 

thêm vào, tốt nhất nên chọn luôn thƣ mục Contacts của Outlook 2010 

 

 Nhấn Next để tiếp tục. Trong cửa sổ cuối cùng, bạn đánh dấu chọn vào ô 

Import “contact.csv” into folder : Contacts. Sau cùng, nhấn Finish để hoàn 

tất. 
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3. Tạo chữ ký cho Email 

 

Chữ ký của bạn có thể tự động đƣợc thêm vào thƣ gửi đi, hoặc bạn có thể tự 

thêm chữ ký để chỉ những thƣ mà bạn chọn. 

a. Nội dung chữ ký Email 

 

Nội dung chữ ký Email  

 

Chữ ký của bạn bao gồm các thông tin về bạn, các nhà kinh doanh thì 

thƣờng để thông tin liên lạc, để các khách hàng và đối tác của họ dễ 

dàng liên lạc với họ.  

Một chữ ký cũng có thể bao gồm một thông điệp tiếp thị hoặc thậm chí 

là một nơi yêu thích để thể hiện giá trị hài hƣớc hay cá nhân  

Thông tin trong một email rất đơn giản với chữ ký có thể bao gồm:  

1 Tên của bạn.  

2 Chuyên môn của bạn.  

3 Địa chỉ và số điện thoại.  

Bạn cũng có thể thêm vào địa chỉ Website, hay một chữ ký bằng tay. 

Logo của công ty, hoặc hình ảnh của mình.  

Hình ảnh, hình ảnh, clip và nghệ thuật có thể làm chậm việc gửi Email. 

Do đó dung lƣợng của các thông điệp bạn thêm vào phải tƣơng đối nhỏ. 
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b. Cách tạo chữ ký trong Email 

 

Mở một tin nhắn mới, trên tab Message, trong nhóm Include, nhấp chuột 

vào Signature, và sau đó bấm vào Signatures. 

 

Trên E-mail Signature tab, bấm vào New. 

 

Nhập tên cho chữ ký, và sau đó nhấn OK. 
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Trong hộp thoại Edit signature, nhập văn bản mà bạn muốn bao gồm 

trong chữ ký 

Để định dạng văn bản, chọn văn bản, và sau đó sử dụng thanh công cụ bên 

dƣới để định dạng 
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c. Đƣa hình ảnh vào chữ ký  

 

Nếu trong chữ ký là một hình ảnh hoặc logo của công ty, thì nó có tác dụng 

giúp khách hàng dễ dàng nhận dạng về bạn hoặc công ty của bạn. Để thêm 

một hình ảnh, nhấp chuột vào nút Picture, chọn hình ảnh và nhấn Insert. 

Lƣu ý hình ảnh có dung lƣợng lớn cần phải resize lại trƣớc khi chèn.  

Bạn có thể thêm vào chữ ký của bạn một liên kết Website. Ví dụ: bạn có thể 

sử dụng để quảng cáo cho một công ty của bạn, của một trang web hoặc để 

ngƣời nhận trực tiếp đến một địa chỉ email. Để liên kết bạn nhấn vào nút 

Insert Hyperlink, ghi địa chỉ bạn cần link tới, nhấn insert. 
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d. Đƣa Business Card vào chữ ký 

 

Business Card (hoặc EBCs) là tính năng mới của Outlook 2010, nó cho 

phép bạn dễ dàng chia sẻ thông tin liên lạc với những ngƣời khác.  

Sau khi tạo một số thông tin cho chính mình, bạn sẽ có một Business Card 

để sử dụng, sau đó bạn có thể đƣa vào chữ ký trong Email: Chỉ cần bấm vào 

nút Business Card trong Chữ ký và hộp thoại sẽ hiển thị nhƣ trong hình 

trên.  

Một EBC sẽ thêm vào một chuyên môn để liên lạc, ngƣời nhận email có thể 

dễ dàng lƣu thông tin liên lạc của bạn, bởi vì một EBC có hai phần: một 

hình ảnh và một tập tin. Tập tin ở định dạng vCard (tiêu chuẩn cho việc gửi 

và nhận thông tin liên lạc trên internet), có nghĩa là thông tin liên lạc, liên 

kết với các thẻ sẽ dễ dàng cho ngƣời nhận để tiết kiệm thời gian. 

e. Chèn một chữ ký tự động 

Trên tab Message, trong nhóm Include , nhấp chuột Signatures. 

Bên dưới mục Choose default signature, Chọn e-mail account và 

chữ ký theo mặc định 



Phiên bản thử nghiệm – Lưu hành nội bộ - Microsoft Vietnam 

 

56 

 

Trong New messages, nhấp vào một tài khoản e-mail mà bạn muốn chữ 

ký làm mằc định. 

Nếu bạn muốn có một chữ ký mặc định khi trả lời hoặc khi chuyển tiếp 

email, trong Replies /forwards, chọn chữ ký. Nếu không bấm (none). 

 

f. Chèn chữ ký bằng tay 

 

Nếu bạn đã tạo chữ ký trƣớc đó, bạn sẽ thấy họ liệt kê ở đây  

Bấm vào Signnature, chọn một chữ ký trong danh sách liệt kê. 

4. Các tính năng khác 

 a. Ƣu tiên theo dõi email bằng cờ  
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Đánh dấu bằng cờ cho Email có tác dụng phân biệt các Email, hoặc làm dấu 

cho các Email quan trọng. Để đánh dấu bằng cờ, hãy làm các bƣớc sau:  

1 Nhấp chuột phải vào tiêu đề Email chọn Follow Up.  

2 Sau đó chọn màu cờ.  

Cách đơn giản hơn, phía bên phải của tiêu đề Email có hình lá cờ mờ, chỉ 

cần nhấp chuột phải để chọn màu cờ để đánh dấu. 

 

b. Thay đổi các mục trong TO-DO BAR  
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Để thay đổi các mục trong TO-DO BAR, hãy làm các bƣớc sau:  

1 Nhấn vào Contacts, thanh công cụ TO-DO BAR sẽ xuất hiện ở bên phải 

Outlook.  

2 Nhấp text ghi là Type a New Task.  

Các từ biến mất và bạn thấy con trỏ (một đƣờng nhấp nháy).  

3 Gõ nhập tên của nhiệm vụ. Nhiệm vụ xuất hiện trong Task Lis của To-Do 

Bar  

4 Nhấn phím Enter.  

 

Nhiệm vụ mới di chuyển xuống Task List của To-Do Bar với những nhiệm 

vụ khác.  
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c. Cách tắt, mở TO-DO BAR  

 

Nếu bạn thích công cụ TO-DO BAR, bạn có thể đƣa nó ra màn hình 

Outlook mà không cần phải vào Contacts. Để thực hiện bạn làm theo cách 

sau đây:  

Nhấn vào View, chọn TO-DO BAR, chọn Normal.  

Để ẩn TO-DO BAR bạn nhấn Alt+ F2 hoặc nhấn vào Minimize the To-Do 

Bar.  

 

Để tắt TO-DO BAR bạn nhấn ALT + F2 hoặc nhấn Close TO-DO BAR  

 

e. Sắp xếp hộp thƣ bằng màu sắc  

Bạn có thể sắp xếp hộp Inbox mail bằng việc đánh dấu màu sắc. VD nhƣ 

bạn chọn màu xanh cho các Email gởi từ công ty, màu tím là các Email 

của bạn học và Màu đỏ là Email của sếp…  

Vào Tab View > From > View Settings 
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Hộp thoại Advanced View Settings hiện thị 

 

Nhấp chọn Conditional Formatting 
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Nhấn nút Add, nhap vào Name: Tomau, click chọn Font và chọn kiểu chữ, 

kích thƣớc chữ, màu đỏ cho Font chữ. 

Chọn Condition…, hiển thị hộp thoại bên dƣới, click chọn From 

 

Chọn tên hoặc địa chỉ ngƣời gởi email > OK 
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e. Đánh dấu các Email bằng thẻ màu Categories 

Color Categories  

Một cách khác trực quan hữu ích để tổ chức các bài viết của bạn là loại 

thêm màu sắc cho họ. Bạn có thể tùy chỉnh mà đối tƣợng email có liên quan 

đến từng loại màu.  

 

Thông báo sẽ có thanh màu sắc thể loại trên đầu trang và bạn có thể phải 

thanh nhấp vào để thay đổi màu sắc.  
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Bạn cũng có thể Nhấp chuột phải vào tin nhắn bên dƣới phần mục để thay 

đổi thể loại.  

 

Bạn có thể đổi tên từng loại thành bất kỳ ý nghĩa đối với bạn.  
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Bạn có thể muốn thực hiện một thể loại mới cho thƣ khác nhau. Go to 

Actions \ Categorize and All 

Categories

 

Trên màn hình Color Categories chọn New nhập các loại tên và màu sắc, 

bạn cũng có thể gán một phím tắt cho nó 
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Bây giờ bạn có thể sắp xếp thông qua các thƣ email của bạn dựa trên loại 

thể  
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f. Tạo các thƣ mục chuyên nghiệp 

 
Mục đích của việc tạo các thƣ mục là để phân loại các Email vào những 

nhóm riêng biệt, và các Email sẽ không còn nằm lẫn lộn với nhau nữa. 

 

 Cách tạo thƣ mục  

 
Cách tạo các thƣ mục này rất đơn giản, chỉ nhấn chuột phải vào INBOX và 

chọn New Folder, đặt tên cho thƣ mục vừa tạo và OK. 

 

 Di chuyển các email vào thƣ mục vừa tạo  
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Sau khi đã tạo ra một thƣ mục, bạn có thể di chuyển các Email vào trong 

thƣ mục đó. Email có thể di chuyển vào thƣ mục này bằng cách kéo thả 

hoặc nhấn chuột vào tiêu đề Email, giữ chặt chuột và di chuyển đến các thƣ 

mục và bạn thả chuột ra. 

 

 Di chuyển các Email vào thƣ mục bằng lệnh 

 
Ngoài cách di chuyển các Email bằng cách kéo và thả thì ta có thể dùng 

lệnh để làm công việc này. Để dùng lệnh di chuyển bạn thực hiện các bƣớc 

sau:  

1 Nhấn chuột phải vào tiêu đề Email.  

2 Chọn Move To Folder.  

3 Chọn thƣ mục bạn muốn lƣu  

4 Ok  

 Tạo quy tắc nhận mail 

g. Cách thức tạo và sử dụng email mẫu 

Nếu sử dụng một dạng email thƣờng ngày đƣợc gởi lặp đi lặp lại cùng một 

dạng nội dung thì tốt nhất bạn nên tạo một email mẫu (template) để đơn 

giản hóa công việc. Những mẫu email thƣờng gặp là: thông tin sản phẩm, 

báo cáo, tin nhắn cho nhóm đối tác... Để tạo một email mẫu, ta thực hiện 

nhƣ sau: 

- Nhấn chọn New trên thanh công cụ để tạo một email mới. Trong giao diện 

soạn thảo, bạn điền tất cả những thông tin, nội dung mà sẽ đƣợc lặp lại theo 

hƣớng khuôn mẫu. Ví dụ nhƣ: tiêu đề, địa chỉ, các phần liệt kê, danh sách 

và các bảng. 
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- Nhấn tiếp vào nút Microsoft Office BuTSn (biểu tƣợng logo của Microsoft 

Office), chọn Save As.  

 

Trong hộp thoại Save As, ta chọn Outlook Template (+.oft) ở phần "Save 

as type", đặt tên cho tập tin mẫu, chọn nơi lƣu rồi Save lại. Tùy thuộc vào 

phiên bản hệ điều hành Windows mà MS Outlook 2010 có vị trí lƣu 

template khác nhau. 

 

+ Windows XP: thƣ mục Documents And SettingsTên tài khoảnApplication 

DataMicrosoftTemplates 
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+ Windows Vista: thƣ mục UsersTên tài 

khoảnAppDataRoamingMicrosoftTemplates 

Có thể tạo nhiều template tùy ý và cùng chia sẻ cho các ngƣời dùng MS 

Outlook khác trên cùng máy sử dụng chung. Khi muốn sử dụng các email 

mẫu, ta chọn mũi tên kế bên New Itém trên tab Home, chọn “More Items”, 

chọn "Choose From...".  

 

Hộp thoại “Choose Form” hiển thị 
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Click chọn “User Template in File System” trong mục “Look In” 

 

Sau khi mở email mẫu, chỉ cần sửa chữa lại thông tin, bổ sung hay thay đổi 

những phần nội dung theo yêu cầu công việc. Bạn sẽ thấy cách này tiết 

kiệm đƣợc rất nhiều thời gian. 

 

h. Sao lƣu và phục hồi Rules trong Outlook 

 

Những bạn nào sử dụng Microsoft Outlook chắc cũng đã từng thiết lập các 

Rule để xử lý email đi vào Inbox theo ý muốn của mình. Đối với nhiều 

ngƣời, số lƣợng Rule đƣợc tạo ra khá lớn và chiếm mất một khoảng thời 

gian không nhỏ. Nếu vì lý do gì đó mà phải tạo lại toàn bộ các Rule thì quả 

là một cực hình. Tôi hy vọng qua bài viết nhỏ này, các bạn có thể thực hiện 

việc sao lƣu các Rule của mình và phục hồi trở lại khi cần thiết. 

 

1. Sao lƣu: 

 

Tại thanh menu của Outlook, các bạn click chọn File -> Info -> chọn Rules 

and Alert. 
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Ở hộp thoại vừa hiển thị ra, chọn Options. 
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Click nút Export Rules. 

 
 

Chọn thƣ mục để lƣu file, đặt tên cho file rồi bấm nút Save. File đƣợc lƣu 

có dạng *.rwz. 

 

2. Phục hồi: 

 

Để phục hồi lại Rule, các bạn click nút Import thay cho nút Export.  
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i. Xóa các thƣ mục chứa Email 

 

Bạn có thể xóa bỏ thƣ mục chứa các email bằng cách: Click chuột phải vào 

thƣ mục muốn xóa, chọn Remove from Favorite Folders. Thƣ mục đó sẽ 

biến mất. Đừng lo lắng vì thƣ mục này vẫn ở trong hộp Inbox, nó chỉ ẩn đi 

thôi. 

j. Tìm Email một cách nhanh chóng 

Tìm Email một cách nhanh chóng (phím tắt Ctrl + E) 

 

Các Email của bạn trong outlook rất nhiều, đôi khi bạn cần tìm kiếm một 

Email cũ nhƣng bạn không biết Email đó nằm ở đâu trong cả ngàn Email 

đƣợc lƣu trong các thƣ mục. Với Outlook 2010 thì bạn sẽ không mất thời 

gian để tìm từng Email nữa. 

k. Tìm Email nhanh với công cụ Instant Search 

Với công cụ Instant Search thi công việc tìm kiếm Email của bạn rất dễ 

dàng, Bạn cần phải có một ít thông tin về Email bạn cần tìm, bạn có thể ghi 
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địa chỉ Email hoặc một số từ ngữ của nội dung Email đó. Tất cả các kết quả 

tìm thấy sẽ hiện ra một cách nhanh chóng. 

Sử dụng tìm kiếm nâng cao 

 

Ctrl+E-> tab Search->nhóm Options->Search Tools->Advanced Find 

 

Hiển thị hộp thoại advanced Find, chọn các yếu tố để tìm kiếm. 
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CHƢƠNG III: QUẢN LÝ HỘP THƢ CỦA BẠN VỀ DUNG LƢỢNG 

VÀ LƢU TRỮ 

 

 

1. Xác định kích thước hộp thư và làm giảm dung lượng  

a. Dung lƣợng của Email  

 

Một số dịch vụ email hoặc các nhà cung cấp hệ thống quản trị viên sẽ 

không cho phép bạn gửi hoặc nhận Email có dung lƣợng lớn, do vậy cần 

phải quản lý dung lƣợng của Email. 

 

b. Xem dung lƣợng hộp thƣ  

Click phải vào thƣ mục > Properties 
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Hiển thị hộp thoại Properties 
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Để nhanh chóng tìm kích thƣớc của hộp thƣ riêng của bạn, sử dụng cửa sổ 

danh mục chính để chuyển sang thƣ mục xem kích cỡ: nhấn vào mục 

Folder Sizes.  

 

Bạn có thể xem đƣợc dung lƣợng của các thƣ mục mà bạn đã lƣu. Thông 

thƣờng dung lƣợng đƣợc tính bằng kilobyte (KB). Các mối quan hệ giữa 

kilobyte, megabyte, và gigabyte là cùng một đơn vị đo lƣờng, bạn có thể đổi 

các thông số đó với nhau: 1024 Kilobyte = 1 Megabyte.  

1.024 Megabyte = 1 Gigabyte.  

 

 

c. Kiểm tra dung lƣợng các thƣ mục bằng Mailbox Cleanup  
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Bạn có thể xem dung lƣợng các thƣ mục trong Mailbox Leanup.Vào tab 

File->Info-> Chọn Cleanup Tools->Mailbox Cleanup. Hộp thoại Mailbox 

Cleanup sẽ hiện ra. 
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Click chọn View Mailbox Size… 
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d. Lƣu các tập tin đã đính kèm vào ổ đĩa  

 

Sau khi xem qua dung lƣợng của các Email, bạn sẽ nhận thấy rằng các 

Email có dung lƣợng lớn thƣờng bao gồm những tài liệu đính kèm. Nếu cần 

để lƣu trữ các tài liệu đính kèm trong hộp thƣ. Bạn sử dụng Lƣu tập tin đính 

kèm các lệnh trên Microsoft Office nút trình đơn và lƣu các tài liệu đính 

kèm vào một số vị trí thuận tiện trên đĩa cứng của bạn.  

Sau khi đã lƣu các tệp đính kèm, bạn có thể xóa các Email không cần thiết 

đó.  
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Trƣớc khi bắt đầu lƣu tài liệu đính kèm vào đĩa cứng, phải nhớ vị trí đã lƣu 

để sau này ngƣời dùng có thể xem lại các tài liệu đó. Để lƣu tập tin đính 

kèm vào ổ đĩa bạn làm theo cách sau:  

1 Mở Email có chứa tập tin đính kèm.  

2 Nhấn vào Tab File 

3 Sau đó bạn chọn Save attachments.  

4 Chọn đƣờng dẫn để lƣu tập tin, sau đó nhấp Ok 

 

e. Xóa vĩnh viễn các Email ra khỏi hộp thƣ  

 

Mỗi khi bạn xóa một email, nó đi vào thƣ mục Deleted Items.Khi xoá nhiều 

thì thƣ mục này có thể phát triển nhanh chóng và chiếm nhiều dung lƣợng, 

do đó cần phải làm sạch thƣ mục Deleted Items cũng nhƣ dung lƣợng của 

toàn hộp thƣ. Bởi vậy, nên xóa vĩnh viễn các Email này ra khỏi hộp thƣ.  

Cách xóa vĩnh viễn các Email đơn giản nhất là vào thƣ mục Deleted Items, 

bạn sẽ thấy các Email xóa bên ngoài. Nhấp chuột vào các Email này, nhấn 

chuột phải chọn Delete.  
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Ngoài ra bạn có thể xoá vĩnh viễn các Email bằng lệnh. Bạn nhấn chuột 

phải vào thƣ mục Deleted Items chọn Empty Folder, chọn Ok. Vậy là tất 

cả các Email trong thƣ mục Deleted Items đã đƣợc xoá ra khỏi hộp thƣ của 

bạn.  

 

f. Tác dụng của Junk Mail  

Junk Mail có tác dụng lọc thƣ rác (Spam mail), giúp cho ta phân loại đƣợc 

thƣ rác nhƣ các thƣ quảng cáo, .... Junk Mail cũng là nơi chứa các thƣ rác 

đó. Junk Mail không muốn các Email rác nằm lẫn lộn với các Email cần 

thiết. 

Thƣ rác hay spam đang ngày càng trở thành một vấn đề nghiêm trọng và 

nếu bạn càng phụ thuộc vào thƣ điện tử bao nhiêu thì nó càng gây khó chịu 

cho bạn bấy nhiêu. Bạn xác định khối lƣợng lọc mà bạn cần và bất cứ thứ gì 

mà Outlook cho là spam sẽ đƣợc đƣa vào bộ lọc Junk Mail Filter để xem 

xét. Bạn cũng có thể thiết lập một danh sách an toàn để bạn có thể bổ sung 

các địa chỉ thƣ điện tử từ những nguồn tin cậy vào đó. Nếu một thƣ điện tử 

từ một nguồn tin cậy tình cờ chui vào trong thƣ mục Junk, việc bổ sung 

ngƣời gửi đó vào danh mục an toàn Safe List rất dễ dàng. 

 

 

2. Di chuyển hoặc sao chép tin nhắn vào các thư mục cá nhân  

a. Căn bản về kho lƣu trữ  
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Email tự động lƣu trữ vào hộp thƣ cá nhân của bạn (hình trên).Với việc sử 

dụng lệnh AotoArchive thì các Email sẽ từ hộp thƣ của bạn sẽ tự di chuyển 

vào thƣ mục, thƣ mục đó gọi là thƣ mục tự lƣu trữ.  
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1 Nhấn Browse… để chọn thƣ mục lƣu trữ, chọn OK.  

2 Email đang di chuyển vào trong hộp thƣ.  

3 Và Email đƣợc lƣu vào thƣ mục tự lƣu trữ.  

Thƣ mục con trong hộp thƣ sẽ đƣợc tự động tạo ra trong thƣ mục lƣu trữ.  

b. Lƣu các email vào thƣ mục cá nhân  
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Bạn muốn có một thƣ mục cá nhân chứa các tập tin riêng của bạn, điều đó 

tƣơng tự để có một tủ đựng các hồ sơ cá nhân. Với thƣ mục cá nhân, bạn 

tạo tập tin riêng cho mình. Sau khi bạn đã tạo ra thƣ mục cá nhân và cách di 

chuyển các tập tin vào thƣ mục cá nhân này. 

 

c. Cách tạo các thƣ mục cá nhân  

 

Để sử dụng một thƣ mục tập tin cá nhân, trƣớc tiên bạn cần phải tạo ra nó. 

Để tạo thƣ mục cá nhân bạn làm theo các bƣớc sau:  

 

1 Chọn file sau đó nhấn vào Info chọn Account Settings  

 

2 Bạn chọn tiếp Tab Data Files  
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3 Chọn Add, nhập tên  

4 Thƣ mục cá nhân của bạn đã đƣợc tạo ra nhƣ hình dƣới. 

 

d. Cách chọn các subfolder trong thƣ mục cá nhân  
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Sau khi bạn tạo xong thƣ mục cá nhân, bạn có thể tạo thêm các thƣ mục con 

subfolder trong thƣ mục cá nhân. Bạn làm điều này từ Cửa sổ Danh mục 

chính:  

Nhấn chuột phải vào thƣ mục My Outlook Data File(1) chọn New Folder.  

Đặt tên cho thƣ mục vừa tạo, nhấn OK.  

Sau đó bạn sẽ thấy một thƣ mục con trong thƣ mục cá nhân của bạn. 

 

e. Di chuyển Email vào thƣ mục cá nhân  
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Sau khi bạn đã tạo xong các thƣ mục con trong thƣ mục các nhân. Để để di 

chuyển một hoặc nhiều Email đến thƣ mục con, bạn làm theo các bƣớc sau:  

1 Nhấn chuột phài vào Email chọn Move to Folder  

2 Bạn chọn thƣ mục con trong thƣ mục cá nhân và nhấn OK.  

Những cách khác để di chuyển các Email vào thƣ mục cá nhân là dùng 

phƣơng pháp kéo thả.  

Bạn nhấn chuột trái vào Email, giữ chặt chuột và di chuyển chuột tới thƣ 

mục con trong thƣ mục cá nhân, sau đó bạn thả chuột ra, Email đó sẽ xuất 

hiện trong thƣ mục cá nhân. 

 

f. Lƣu trữ emai ra ổ đĩa  

 

Thông thƣờng bạn lƣu trữ các Email vào thƣ mục cá nhân. Nhƣng các thƣ 

mục này vẫn nằm trong Outlook. Tuy nhiên có cách để back up dữ liệu 

khác là lƣu trữ các Email vào ổ đĩa.  



Phiên bản thử nghiệm – Lưu hành nội bộ - Microsoft Vietnam 

 

89 

 

 

File > Info > Account Settíng 

  

 

Tab Data Files > chọn dòng muốn lƣu trữ hoặc di chuyển > Open File 

Location 
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Chọn Move this file hoặc Copy this file 

Lƣu ý: Nếu mục tiêu của bạn là để sao lƣu toàn bộ hộp thƣ của bạn, thì bạn 

mới dùng công cụ này. 

g. Phân loại thƣ 

Đôi khi tài khoản email của bạn sẽ bị quá tải do mỗi ngày bạn phải nhận 

hàng trăm email từ khách hàng, đối tác, nội bộ công ty. Do đó, việc phân 

loại tự động email sẽ giúp giảm bớt thời gian rất nhiều. Công việc trƣớc tiên 

bạn cần làm là tạo các thƣ mục bằng cách nhấn phải chuột lên Inbox rồi 

chọn New Folder, đặt tên tùy ý. Ví dụ: "Mail đối tác" rồi nhấn OK. Cứ tiếp 

tục tạo thƣ mục nếu bạn có nhiều phân loại ngƣời dùng. 

Bƣớc tiếp theo, bạn chọn : 

1 Nhấn chuột phải vào tiêu đề Email.  

2 Chọn Rules.  
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Trong cửa sổ mới, ta chọn quy tắc cho email gởi đến tƣơng ứng với yêu cầu 

công việc.  

 

Ở đây ta chọn Select Folder 
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Chọn thƣ mục đã đƣợc tạo sẵn hoặc nhấn nút New để tạo thƣ mục khác, rồi 

nhấn OK 

Trong mục  "Move the item to folder" sẽ giúp tự động đƣa tất cả email từ 

một địa chỉ email xác định vào một thƣ mục đƣợc chỉ định sẵn.  

 

Bạn có thể tham khảo khá nhiều quy tắc và hành động (action) mà MS 

Outlook đã có sẵn để ta chọn lựa theo cách thức nhƣ trên khi nhấn vào nút 

Advanced Options. 
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Chọn điều kiện cho quy tắc nhận email 



Phiên bản thử nghiệm – Lưu hành nội bộ - Microsoft Vietnam 

 

94 

 

 

 

Chọn hành động (action) cho quy tắc nhận thƣ 
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Chọn điều kiện loại trừ cho quy tắc nhận thƣ 
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Đặt tên và nhấn Finish để hoàn thành. Bây giờ, thƣ của các bạn sẽ đƣợc tự 

động chuyển vào từng thƣ mục nhất định.  

Các thao tác khác: 

 

Trong hộp thoại Rules and Alerts 
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- Change Rule: chỉnh sửa điều kiện. 

- Copy Rule: sao chép điều kiện 

- Delete: xóa điều kiện 

- Run Rules Now: thực hiện ngay một điều kiện nào đó. 

3. Lưu trữ các thư từ cũ  

a. Làm quen với AutoArchive  

Để vào hộp thoại AutoArchive bằng cách nhấp chuột vào File chọn 

Options.  

 

 

Nhấp chuột vào Advanced và sau đó nhấp chuột vào nút AutoArchive 

Settings.  
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Hộp thoại Auto Archive hiển thị. 

 

1 Nếu chọn Run AutoArchive every (số ngày) thì AutoChive sẽ kiểm tra 

hộp thƣ tùy theo số ngày bạn chọn. (Và nếu bạn không thích AutoArchive, 

bạn có thể không chọn nó).  

2 Số lƣợng ngày cho biết với tần số mà AutoArchive sẽ chạy.  

b. Xác định Email cũ trong AutoArchive  
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Với AutoArchive, mỗi lần Email bị di chuyển sẽ nhận đƣợc một thông báo 

kiểm tra. Tuy nhiên, đôi khi bạn không nhận đƣợc thông báo kiểm tra, do 

AutoArchive đƣợc cài đặt mặc định. Sau khi di chuyển thì những Email đó 

đƣợc cho là cũ và bạn có thể thay đổi điều này.  

Đối với một số ngƣời Email có vẻ cũ sau khi hai tuần, nhƣng đối với ngƣời 

khác thì có thể là 2 tháng. Bạn là một đƣợc quyết định và bạn có thể làm 

đƣợc điều này trên một cơ sở cho mỗi thƣ mục nếu bạn muốn.  

 

 

 

g. Lƣu trữ Calendar 

AutoArchive có nhiều tác dụng ngoài việc lƣu trữ các Email. AutoArchive 

còn lƣu trữ đƣợc các nhiệm vụ đặt trong Calendar hoặc các thƣ mục trong 

nó. Và cũng giống nhƣ cách điều chỉnh cài đặt cho Email. 

 

http://lh3.ggpht.com/_KSOH77vnC-4/SvAOAf4BF1I/AAAAAAAAAu4/8TZlOk9_egM/image017_thumb%5B1%5D.jpg?imgmax=800
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Click phải vào Calendar muốn lƣu trữ, chọn Properties. 

Chọn Tab AutoArchive, bạn có thể tùy chỉnh các cài đặt cho các Calendar. 

 

 

 

Khi mở các thƣ mục đƣợc lƣu dƣới dạng file PST bân nên lƣu ý. Một khác 

biệt lớn giữa file PST với các loại file khác là bạn không thể mở một tập tin 

PST bằng cách dùng chuột double-click vào file này. Nếu bạn thử, bạn sẽ 

thấy một thông báo tƣơng tự với hình trên.  

 



Phiên bản thử nghiệm – Lưu hành nội bộ - Microsoft Vietnam 

 

101 

 

CHƢƠNG IV: SỬ DỤNG LỊCH LÀM VIỆC MỘT CÁCH HIỆU QUẢ 

1. Căn bản về Outlook Calendar  

a. Tạo các mục trong Calendar  

 

Giao diện Calendar trong Outlook 2010.  

Không chỉ đơn thuần là phần mềm dùng để gởi nhận email. Outlook còn là 

một công cụ đắc lực giúp bạn quản lý thời gian làm việc của mình. Bạn có 

thể thiết lập cho Outlook tự động thông báo lịch làm việc cho bạn theo 

ngày, tuần hoặc tháng trong phần Calendar (lịch). 

Đầu tiên bạn vào mục Calendar trong Outlook bằng cách nhấp vào thanh 

Calendar bên trái cửa sổ mail. 

Lúc này bạn sẽ thấy cửa sổ Calendar hiện ra, click chọn nút Day, Work 

Week, Week, Month trên thanh công cụ để xem lịch ngày, tuần hoặc tháng.  
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Hình 7  

Click đôi chọn một thời điểm trong khung Calendar để tạo một lịch hẹn. 

Cửa sổ Untitled - Appointment xuất hiện để bạn điền thông tin việc cần làm. 

 

Điền tên công việc và nơi thực hiện công việc trong khung Subject và 

Location. 

Chọn mức độ quan trọng của công việc trong khung Label. 

Chọn thời gian bắt đầu và thời gian kết thúc công việc trong khung Start 

Time và End Time. Nếu là sự kiện cả ngày bạn có thể click chọn dòng All 

day event. 
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Để Outlook tự động thông báo khi lịch đến, bạn phải click chọn dòng 

Reminder. Tốt nhất bạn nên chọn khoảng thời gian thông báo trƣớc 10, 15 

hoặc 30 phút... trong khung kế bên. 

Nếu bạn muốn Outlook thông báo lịch hẹn bằng âm nhạc bạn có thể click 

nút biểu tƣợng hình cái loa để chọn bài nhạc ƣa thích. (Chƣơng trình chỉ hỗ 

trợ nhạc có định dạng đuôi chấm wav.). 

l 
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l  

Cuối cùng nhấp Save and Close để lƣu và đóng lại những thiết lập vừa thực 

hiện. Nhƣ vậy, khi có lịch đến Outlook sẽ tự động bật bảng thông báo công 

việc kèm theo bài nhạc bạn đã chọn. 

 

b. Kiểm tra Calendar  

 

Khi vào Calendar bạn có thể nhìn thấy những nhiệm vụ, lịch các cuộc hẹn 

hay các sự kiện mà bạn đã tạo ra trong calendar. Cách xem nhiệm vụ trong 

Calendar:  

Nhấn vào biểu tƣợng lịch.  

Click vào một ngày trên lịch, bạn sẽ thấy các nhiệm vụ hoặc các cuộc hẹn 

mà bạn đã sắp xếp sẽ xuất hiện trên To-Do Bar.  
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Khi bạn đang tìm ngày tháng trên lịch thì bạn có thể công cụ ở phía trên để 

di chuyển ngày tháng một cách dễ dàng:  

1 Nhấn vào Day, Week, Mooth để nhanh chóng chuyển đổi thời gian ngày 

tháng muốn xem.  

2 Dùng phím mũi tên để di chuyển ngày tháng một cách tiện lợi 

3 Có thể cho hiển thị hoặc ẩn ngày phụ thuộc vào cách xem của bạn. 
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c. Chọn lựa cách lập biểu trong Calendar  

 

Bởi vì các yêu cầu khác nhau, nên bạn phải lập biểu khác nhau cho các yêu 

cầu đó.  

Cuộc hẹn: Một cuộc hẹn cần diễn ra chính xác theo thời gian, do đó ta sẽ 

lập biểu tại một thời gian.  

Cuộc họp: Một cuộc họp xảy ra tại một thời gian, dự kiến, giống nhƣ một 

cuộc hẹn. Sự khác biệt là bạn sẽ mời những ngƣời khác bằng cách sử dụng 

một cuộc họp yêu cầu đƣợc gửi qua email.  

Sự kiện: Một sự kiện là một hoạt động kéo dài cả ngày dài. Không giống 

nhƣ một cuộc hẹn hoặc cuộc họp, một sự kiện. Với một sự kiện, bạn vẫn có 

thể có các mục xuất hiện trong lịch trình của bạn cho ngày hôm đó.  
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Nhiệm vụ: Một nhiệm vụ là một yêu cầu bạn làm gì đó trong một khoảng 

thời gian, bạn có thể lập biểu nhiệm vụ cho mỗi ngày  

 

d. Tạo các cuộc hẹn  

Để nhập một cuộc hẹn, làm theo các bƣớc sau đây:  

1 Nhấp biểu tƣợng Calendar trong Outlook Bar.  

 

Lịch xuất hiện, trình bày các cuộc hẹn của bạn  

2 Nhấp nút New trong thanh công cụ ở phần trên cùng của màn hình.  

Form New Appointment xuất hiện.  
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3 Nhấp hộp Subject và nhập một tên cho cuộc hẹn.  

Nhập nội dung mô tả cuộc hẹn, chẳng hạn nhƣ “Có hẹn với John, 

Microsoft”.  

4 Nhấp tam giác kế bên hộp Start Time.  

Một lịch nhỏ xuất hiện  
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e. Tạo lịch cho các cuộc họp  

 

Khi tạo lịch cho cuộc họp, các yếu tố cần phải có là thời gian, thành phần 

tham dự và địa điểm cuộc họp. Nếu bạn đã thiết lập một cuộc họp, trong khi 

đó bạn lại có một cuộc họp khác thì nó sẽ báo cho bạn biết hai cuộc họp 

trùng giờ. Trong một cuộc họp bạn sẽ thấy những:  

1 Địa điểm của cuộc họp  

2 Tên của cuộc họp  

 

f. Tạo lịch cho việc tham gia hội thảo  

 

Nếu sử dụng Outlook, bạn có thể kiểm tra thời biểu của mọi ngƣời, chọn 

một khoảng thời gian và đề nghị một thời gian hội thảo mà mọi ngƣời có 

thể tham gia bằng Email.  

http://lh6.ggpht.com/_KSOH77vnC-4/SvAPcz5OqHI/AAAAAAAAAxI/e7-8IlFVz1Y/image007_thumb%5B1%5D.jpg?imgmax=800
http://lh6.ggpht.com/_KSOH77vnC-4/SvAPcz5OqHI/AAAAAAAAAxI/e7-8IlFVz1Y/image007_thumb%5B1%5D.jpg?imgmax=800
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Để mời một số ngƣời tham gia hội thảo, làm nhƣ sau:  

1 Chọn File > New > Meeting Request (hoặc nhấn Ctrl+ Shift+Q).  

 

Form New Appointment mở ra.  

2 Click nút Scheduling.  
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Trang Attendee Availability xuất hiện. Sử dụng trang Attendee 

Availability để mời những đồng sự dự một cuộc hội thảo.  

3 Một danh sách xổ xuống xuất hiện.  

4 Chọn Add from Address Book.  

Hộp thoại Select Attendees and resources xuất hiện.  

5 Click tên của một ngƣời mà bạn muốn mời dự hội thảo.  

Tên bạn click đƣợc bật sáng để cho thấy bạn đã chọn nó.  

6 Click nút Required hoặc Optional phụ thuộc vào việc sự tham dự của 

ngƣời đó có tầm quan trọng đối với cuộc hội thảo nhƣ thế nào.  

Tên mà bạn chọn xuất hiện trong hộp Required hoặc Optional phụ thuộc 

vào nút nào bạn click.  

7 Lặp lại các bƣớc 5 và 6 cho đến khi bạn đã chọn mọi ngƣời mà bạn muốn 

thêm vào cuộc hội thảo.  

Các tên mà bạn chọn xuất hiện trong hộp thoại Select Attendees and 

Resources  
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Bạn có thể chọn những bạn bè của bạn và bạn có thể chọn các cuộc hội thảo 

của bạn.  

8 Click OK.  

Hộp thoại Select Attendees and Resources đóng lại và các tên mà bạn đã 

chọn xuất hiện trong Attendee Availability List. Danh sách Attendee 

Availability cũng cho bạn thấy một sơ đồ về thời biểu của mỗi ngƣời để 

bạn có thể thấy khi nào mỗi ngƣời có thời gian rảnh.  

9 Thời gian bạn chọn xuất hiện trong hộp Meeting Start Time nằm ở cuối 

danh sách Attendee Availability. Nếu bạn không thấy một khoảng thời gian 

mà mọi bạn mời dự cuộc hội thảo của bạn có sẵn, click nút Autopick Next 

và Outlook sẽ tìm một thời gian hội thảo khả thi cho mọi ngƣời.  

10 Click nút Appointment.  

Trang Appointment xuất hiện với tên của những ngƣời mà bạn đã mời dự 

hội thảo trong hộp To nằm ở phần trên cùng của form.  

11 Gõ nhập chủ đề của cuộc hội thảo trong hộp Subject.  

12 Nhập bất kỳ thông tin khác mà bạn muốn những ngƣời tham dự biết về 

cuộc hội thảo.  

Bạn có thể đƣa vào địa điểm hoặc hạng mục.  

13 Click Send.  

Yêu cầu tham gia hội thảo của bạn đƣợc gởi đến thành phần tham dự. 

g. Kiểm tra các nhiệm vụ đã tạo ra  

 

Khi tạo ra một nhiệm vụ trong Calendar thì không cần phải đƣợc lập kế 

hoạch cho một thời gian cụ thể trong ngày. Bạn sẽ thấy các khu vực chung 

khi bạn nhìn vào trong lịch Tuần, Ngày thƣờng xem nhất.  



Phiên bản thử nghiệm – Lưu hành nội bộ - Microsoft Vietnam 

 

113 

 

Ví dụ, nếu bạn có một số công việc cần phải làm, chỉ cần nhập công việc đó 

nhƣ là một nhiệm vụ. Khi bạn hoàn thành một nhiệm vụ, kiểm tra nó. Khi 

nhiệm vụ hoàn thành trong một ngày xác định sẽ có một danh sách hoàn 

thành nhiệm vụ hiện thị ngày đó. Trong hình trên: các công việc đã hoàn 

thành một kiểm tra và đánh dấu một dòng gạch giữa tiêu đề nhiệm vụ và 

thời gian hoàn thành. 

 

Bạn có thể nhập một nhiệm vụ với ngày dự kiến bắt đầu và ngày kết thúc 

nhiệm vụ. Nếu bạn không hoàn thành một nhiệm vụ trƣớc ngày kết thúc, nó 

sẽ tự động chuyển tiếp và xuất hiện trên những ngày hiện tại cho đến khi 

bạn hủy bỏ nó hay kiểm tra để điều chỉnh nó. 

 

h. Các ứng dụng ngoài việc gửi Email trong Outlook  

 

Trong Outlook thì Calendar giúp bạn tiết kiệm đƣợc nhiều thời gian. Giúp 

bạn làm các công việc nhƣ: nhắc bạn về thời gian, giúp bạn làm đƣợc nhiều 

việc hơn trong thời gian ít hơn…  

Nói về thời gian, Outlook nhắc nhở bạn về các cuộc họp quan trọng giúp ta 

luôn luôn chủ động để sắp xếp công việc. Outlook cũng cho phép bạn hiển 

thị thời gian rảnh của bạn cho ngƣời khác biết, để họ có thể xem khi nào 

bạn sẵn sàng trao đổi công việc với họ. 

 

i. Hiển thị lại các nhiệm vụ  

http://lh6.ggpht.com/_KSOH77vnC-4/SvAPfdxMjjI/AAAAAAAAAxY/p2VSgJ5Umcc/image009_thumb%5B1%5D.jpg?imgmax=800
http://lh6.ggpht.com/_KSOH77vnC-4/SvAPfdxMjjI/AAAAAAAAAxY/p2VSgJ5Umcc/image009_thumb%5B1%5D.jpg?imgmax=800
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Các nhiệm vụ đƣợc nhập sẽ đƣợc hiển thị nhiều lần mà bạn không cần phải 

nhập lại nhiệm vụ đó. Outlook sẽ nhắc nhỡ nhiều lần về nhiệm vụ đó theo ý 

của bạn. Dƣới đây là thanh công cụ điều chỉnh nó.  

 

 

j. Điều chỉnh nhiệm vụ theo định kỳ  
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Khi mở Calendar để xem các mục nhiệm vụ hoặc cuộc hẹn trong đó. Ta có 

thể xem lại các chi tiết hoặc thay đổi nó. Để thay đổi ta làm các bƣớc:  

Nhấn double vào mục lục, bạn sẽ thấy một thông báo nhƣ một trong hình, 

sẽ có hai lựa chọn:  

Open this occurrence: có thể xem hoặc thay đổi nội dung.  

Open the series: có thể thay đổi thời gian của toàn bộ mục nhiệm vụ hoặc 

cuộc hẹn này  

Sau khi chọn Open the series để thay đổi, nhấn vào nút Recurrence sau đó 

chọn tab Appointment.  

 

Không nên xoá mục nhập theo định kỳ.  

Ta có thể điều chỉnh thời gian của của chu kỳ hiển thị mục nhiệm vụ đó.  

 

k. Chọn cách nhắc nhở  

 

Khi bạn tạo ra bất kỳ mục nào trong Calendar (Mục nhiệm vụ hoặc mục 

thông báo cuộc hẹn), một lời nhắc nhở đƣợc thiết lập tự động. Outlook sẽ 

thông báo cho bạn về cuộc hẹn và các cuộc họp 15 phút trƣớc khi cuộc họp 

bắt đầu. Trong hình trên thể hiện các bƣớc để thay đổi thời gian nhắc nhở 

cho bất kỳ mục lịch bằng cách mở các mục nhập và điều chỉnh các cài đặt 

trong hộp Reminder trên tab Appoiment.  
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1 Nhấn Double vào cuộc hẹn để mở nó.  

2 Chọn thời gian nhắc nhở  

3 Một nhắc nhở sẽ xuất hiện ở thời gian xác định.  

 

Các sự kiện sẽ đƣợc nhắc nhở tự động, Outlook sẽ thông báo cho bạn về sự 

kiện 18 giờ trƣớc khi họ bắt đầu. Bạn không thể thay đổi thiết lập tự động 

này, nhƣng bạn có thể sử dụng cùng một bƣớc mà chúng tôi đã hiển thị 

trong hình để thay đổi lời nhắc cho các sự kiện. 

 

l. Tô màu cho các hạng mục  
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Làm theo các bƣớc sau đây để thay đổi màu của một hạng mục:  

1 Click nút Categories và chọn All Categories.  

Hộp thoại Color Categories xuất hiện.  

2 Click hạng mục mà bạn muốn gán một màu mới.  

Hạng mục bạn chọn đƣợc bật sáng.  

3 Click nút Color.  

Một hộp xổ xuống xuất hiện, hiển thị các màu mà bạn có thể chọn.  

4 Chọn màu mà bạn muốn gán.  

Màu mà bạn đã chọn xuất hiện thay thế cho màu cũ.  

5 Click OK.  

Hộp thoại Color Categories đóng lại.  

 

2. Xem và sử dụng nhiều lịch làm việc  

a. Tạo một Calendar mới  
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Để tạo một Calendar mới bạn làm các bƣớc sau:  

1 Nhấn nút phải vào Calendar chọn New Calendar 

2 Hộp thoại Crete New Folder xuất hiện.  

 

3 Bạn nhập tên cho Calendar muốn tạo sau đó nhấn OK  

4 Một Calendar mới sẽ xuất hiện trong mục My Calendar. 
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b. Quản lý các thƣ mục cá nhân  

  

Sau khi tạo thêm các Calendar mới, các Calendar sẽ xuất hiện trong My 

calendar. Chúng ta sẽ xem nhiều Calendar theo hình trên. 

Muốn xem đƣợc lịch của Calendar nào thì bạn đánh dấu check vào một ô 

trƣớc tiêu đề của Calendar đó. Bên cột hiển thị sẽ thấy đƣợc toàn bộ thƣ 

mục trong Calendar đó.  

Nếu bạn muốn xem hết toàn bộ các Calendar thì chỉ việc đánh dấu hết cho 

tất cả các Calendar. Khi đó cột hiển thị sẽ thấy đƣợc tất cả các Calendar.  

Nếu bạn không muốn hiển thị Calendar nào thì chỉ việc bỏ dấu check đi 

 

c. Tạo một cuộc hẹn ở nhiều Calendar  

 

Đôi khi bạn muốn có một cuộc hẹn đƣợc để ở hai Calendars khác nhau. Bạn 

sẽ tạo từng cuộc hẹn trong từng Calendar. Bạn không nên làm cách này vì 

http://lh5.ggpht.com/_KSOH77vnC-4/SvAPu0Mh4FI/AAAAAAAAAyk/So0UAbg-9Bo/image016_thumb%5B1%5D.jpg?imgmax=800
http://lh5.ggpht.com/_KSOH77vnC-4/SvAPu0Mh4FI/AAAAAAAAAyk/So0UAbg-9Bo/image016_thumb%5B1%5D.jpg?imgmax=800
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sao chép một cuộc hẹn từ Calendars này sang Calendar khác rất đơn giản: 

Trƣớc hết bạn cho hiển thị cả hai Calendars, sau đó dùng phƣơng pháp kéo 

thả, kéo thƣ mục chứa cuộc hẹn từ Calendar này và thả vào Calendar kia. 

 

d. Tạo nhóm cho các Calendar trong Navigation Pane  

 

Trƣớc hết phải phân nhóm cho các Calendars mà bạn đã tạo ra theo tên của 

từng Calendar.  

Trong hình trên thể hiện các bƣớc để tạo một nhóm mới và cách di chuyển 

các Calendar: 

1 Click phải vào Calendar, chọn  New  Calendar Group.  

 

2 Nhập tên cho nhóm vừa tạo.  

3 Dùng phƣơng pháp kéo thả, kéo các Calendars bạn chọn đƣa vào các 

nhóm vừa tạo ra. 

e. Sử dụng và chia sẻ Calendar 

Import Calendar  

Outlook không giới hạn cho phép bạn chỉ sử dụng đƣợc 1 lịch biểu mà có 

thể tạo ra nhiều nếu bạn cần. Điều này có lúc rất cần thiết bởi đôi khi bạn 

muốn phân lịch làm việc  riêng biệt giữa công việc  với việc cá nhân. Bạn 

http://tag.phanvien.com/l%C3%A0m+vi%E1%BB%87c.html
http://tag.phanvien.com/c%C3%B4ng+vi%E1%BB%87c.html
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thậm chí có thể sử dụng nhiều lịch biểu để xem và quản lý kế hoạch  làm 

việc  của các nhân viên  khác nhau.  

Nếu bạn đã có lịch biểu sẵn từ một máy tính  hay một chƣơng trình  khác, 

có thể import nó vào Outlook. Tuy nhiên, phải chắc chắn là bạn export lịch 

biểu đó ra đúng định dạng  iCalendar hoặc vCalendar.  

Để export dữ liệu  từ Outlook ra, không sử dụng trình Import and Export 

sẵn có mà bạn hãy vào tab Calendar trong Outlook, vào File > Save 

Calendar.  

 

 

Trên cửa sổ Save As, kích vào nút More Options để xác định chính xác  

loại thông tin  mà bạn muốn export. Cuối cùng, lƣu nó về định dạng  

iCalendar (.ics).  

 

Sau khi đã có một file định dạng  iCalendar hoặc vCalendar, bạn có thể 

đƣa thông tin  đó vào Outlook bằng một trong 2 phƣơng thức khác nhau. 

http://tag.phanvien.com/k%E1%BA%BF+ho%E1%BA%A1ch.html
http://tag.phanvien.com/l%C3%A0m+vi%E1%BB%87c.html
http://tag.phanvien.com/l%C3%A0m+vi%E1%BB%87c.html
http://tag.phanvien.com/nh%C3%A2n+vi%C3%AAn.html
http://tag.phanvien.com/m%C3%A1y+t%C3%ADnh.html
http://tag.phanvien.com/ch%C6%B0%C6%A1ng+tr%C3%ACnh.html
http://tag.phanvien.com/%C4%91%E1%BB%8Bnh+d%E1%BA%A1ng.html
http://tag.phanvien.com/d%E1%BB%AF+li%E1%BB%87u.html
http://tag.phanvien.com/ch%C3%ADnh+x%C3%A1c.html
http://tag.phanvien.com/th%C3%B4ng+tin.html
http://tag.phanvien.com/%C4%91%E1%BB%8Bnh+d%E1%BA%A1ng.html
http://tag.phanvien.com/%C4%91%E1%BB%8Bnh+d%E1%BA%A1ng.html
http://tag.phanvien.com/th%C3%B4ng+tin.html
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Mở nó nhƣ một lịch biểu mới bạn sẽ thấy nó hiển thị nhƣ một lịch biểu độc 

lập. Để mở nhƣ một lịch biểu mới, kích vào File > Open > Open 

Calendar.  

 

Một phƣơng thức khác bạn có thể sử dụng là Import and Export. Kích vào 

File > Open >Import, chọn tùy chọn lịch biểu và kích vào Next, tìm và 

chọn đến file bạn đã export, sau đó chọn phƣơng thức sử dụng.  
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Thêm các ngày nghỉ lễ vào lịch biểu  

Lịch biểu sẽ không phát huy hết tác dụng khi mà các kỳ nghỉ không 

đƣợcđánh dấu sẵn. Mặc dù Microsoft  không tự động đƣa vào các ngày 

nghỉ nhƣng bạn có thể. Có một cách dễ dàng để làm điều đó là tìm kiếm  

trênmạng và thêm lịch biểu Internet  đã đƣợc đánh dấu sẵn đó vào 

Outlook.  

Một thƣ mục lịch biểu Internet  phổ biển nhất là iCalShare.Tuy nhiên, lịch 

biểu này chỉ đánh dấu những ngày nghỉ lễ của Mỹ, do đó bạn sẽ phải tìm 

kiếm  một lịch biểu phù hợp hơn hoặc tự mình tạo ra lịchbiểu có đánh dấu 

đầy đủ các ngày nghỉ lễ.  

Chia sẻ lịch biểu với các tài khoản Windows  khác  

 

Để chia sẻ  cùng một file dữ liệu  Outlook cho tài khoản khác, trƣớc 

tiênbạn phải export file đã có vào một thƣ mục chung để các tài 

khoảnWindows khác có thể truy cập  (ví dụ nhƣ thƣ mục Public của 

http://tag.phanvien.com/Microsoft.html
http://tag.phanvien.com/t%C3%ACm+ki%E1%BA%BFm.html
http://tag.phanvien.com/Internet.html
http://tag.phanvien.com/Internet.html
http://icalshare.com/
http://tag.phanvien.com/t%C3%ACm+ki%E1%BA%BFm.html
http://tag.phanvien.com/t%C3%ACm+ki%E1%BA%BFm.html
http://tag.phanvien.com/Windows.html
http://tag.phanvien.com/chia+s%E1%BA%BB.html
http://tag.phanvien.com/d%E1%BB%AF+li%E1%BB%87u.html
http://tag.phanvien.com/truy+c%E1%BA%ADp.html
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Vista). Mặc định vị trí đặt các file dữ liệu  về Outlook trong Vista là tại: 

C:\Users\username\AppData\Local\Microsoft\Outlook.Đơn giản bạn chỉ 

cần copy  file này vào một vị trí chung cho toàn bộ tàikhoản. Sau đó đối với 

mỗi một tài khoản Windows, hãy thêm file dữ liệuđã copy  này vào đƣờng 

dẫn Outlook tƣơng tự nhƣ trên và xóa file mặcđịnh đi.  

Chia sẻ lịch biểu thông qua “Share Calendar”  

Nếu sử dụng Outloook cùng với Exchange Server, bạn có thể chọn để Share 

Calendar cho các đồng nghiệp khác xem. Vd: user2 share calendar cho 

user1 

 

Chọn account để gởi đi 

 

Nhấp chọn “Request permissionto view recipient„s Calendar” cho phép user 

gởi đi trong trong phần To xem calendar. 

http://tag.phanvien.com/d%E1%BB%AF+li%E1%BB%87u.html
http://tag.phanvien.com/copy.html
http://tag.phanvien.com/copy.html
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Khi user1 nhận đƣợc email, nhấn vào nút Open this Calendar 

 

Trong mục Calendar user1 sẽ thấy đƣợc Calendar của user 2. 

 

Để gán thêm nhiwfu quyền cho user khác trên Calendar, chọn Calendar 

Permisions, chọn Add thêm user và chỉnh trong phần Permission Level 
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Chia sẻ lịch biểu thông qua Internet  

Có vài cách để bạn có thể chia sẻ  lịch biểu thông qua Internet:  

- Gửi theo file đính kèm qua email: Để thực hiện theo cách này, bạn chỉ 

cần kích vào link Send a Calendar via E-mail ở phía bên trái chƣơng 

trình  hoặc kích chuột phải vào tab lịch biểu cần gửi và chọn Send via E-

mail.Bạn sẽ thấy một email mới đƣợc mở ra kèm theo hộp thoại cho phép 

chọnthông tin lịch biểu muốn gửi. Lƣu ý rằng với cách gửi này bạn mới 

chỉgửi một hình ảnh  chụp của lịch biểu và ngƣời nhận sẽ không thể thực 

hiện bất kỳ thay đổi nào. 

http://tag.phanvien.com/chia+s%E1%BA%BB.html
http://tag.phanvien.com/ch%C6%B0%C6%A1ng+tr%C3%ACnh.html
http://tag.phanvien.com/ch%C6%B0%C6%A1ng+tr%C3%ACnh.html
http://tag.phanvien.com/h%C3%ACnh+%E1%BA%A3nh.html
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- Chia sẻ lên Office  Online: Để thực hiện theo cách này, kích chuột phải 

vào tab lịch biểu muốn chia sẻ  và chọn Publish to Internet > Publish to 

Office  Online.Trƣớc tiên bạn sẽ đƣợc nhắc nhở đăng nhập hoặc tạo một tài 

khoảnWindows Live. Sau khi đã có một tài khoản hoặc đã đăng nhập, bạn 

có thểchia sẻ lịch biểu của mình trên trang Office  Online. Bạn có thể xem 

vàchỉnh sửa lịch biểu online, sau đó gửi nó đến cho những ngƣời khác, 

khiđó lịch biểu sẽ tự động thay đổi trên máy tính  của họ khi bạn thực 

hiệnsự thay đổi. Để truy cập  Hình 5: Chia sẻ  lịch biểu lên Office  Online 

http://tag.phanvien.com/Office.html
http://tag.phanvien.com/chia+s%E1%BA%BB.html
http://tag.phanvien.com/Office.html
http://tag.phanvien.com/Office.html
http://tag.phanvien.com/m%C3%A1y+t%C3%ADnh.html
http://tag.phanvien.com/truy+c%E1%BA%ADp.html
http://tag.phanvien.com/Chia+s%E1%BA%BB.html
http://tag.phanvien.com/Office.html
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- Chia sẻ thông qua trang WebDAV:Cách này tƣơng tự nhƣ Office  

Online  nhƣng là thông qua một dịch vụ  củabên thứ ba. Để chia sẻ  theo 

cách này, kích chuột phải vào tab lịch biểucần chia sẻ, chọn Publish to 

Internet > Publish to WebDAV Server  

Ngoài ra, nếu bạn là “fan” ruột của Google, bạn cũng có thể sẽ thích dịch 

vụ  Google Calendar Sync.Dịch vụ này cho phép bạn đồng bộ hóa Google  

Calendar với lịch biểu củaOutlook và lúc đó bạn có thể sử dụng những tính 

năng ƣa thích của mình. 

 

CHƢƠNG V: QUẢN LÝ CÁC THÔNG TIN 

a. Tạo các thông tin về bản thân  

http://tag.phanvien.com/Office.html
http://tag.phanvien.com/Online.html
http://tag.phanvien.com/d%E1%BB%8Bch+v%E1%BB%A5.html
http://tag.phanvien.com/chia+s%E1%BA%BB.html
http://tag.phanvien.com/d%E1%BB%8Bch+v%E1%BB%A5.html
http://tag.phanvien.com/d%E1%BB%8Bch+v%E1%BB%A5.html
http://www.google.com/support/calendar/bin/answer.py?answer=89955
http://tag.phanvien.com/Google.html
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Để tạo một business card cho chính mình, chỉ cần tạo một số thông tin liên 

lạc cho mình. Trong mẫu liên hệ, bạn sẽ thấy loại thông tin liên lạc của 

riêng bạn. Outlook có những form để bạn ghi vào. Form này là business 

card của bạn. Nếu bạn có nhiều công việc khác nhau thì có thể tạo ra nhiều 

business card khác nhau nhằm thể hiện từng vai trò trong các Email khác 

nhau.  

 

c. Thêm và xóa thông tin trên Business Card  
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Các thông tin về bạn xuất hiện trên các Business Card đƣợc liệt kê trong 

hộp thoại Fields, (hình trên). Bạn có thể thay đổi các lĩnh vực đang hiển thị 

trên thẻ của bạn bằng cách thêm hoặc loại bỏ chúng khỏi danh sách.  

1 Để thêm thông tin mới vào Business Card, bạn nhấn vào Add trong hộp 

thoại Fields, chọn các danh mục có sẵn và thêm thông tin vào.  

2 Để xóa một lĩnh vực trên Business Card, bạn chọn lĩnh vực cần xoá, sau 

đó nhấn vào Remove trong hộp thoại . 

 

d. Chuyển đổi các thông tin trên Business Card  
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Trong Business Card, bạn có thể thay đổi vị trí các lĩnh vực một cách dễ 

dàng.  

Để di chuyển các lĩnh vực trong business card: chọn các lĩnh vực trong 

danh sách, và sau đó sử dụng nút Move Field Up và Move Field Down (là 

các nút hình mũi tên) để di chuyển.  

Nhƣ hình trên, để thay đổi vị trí giữa tên công ty và lĩnh vực ta làm các 

bƣớc sau:  

1. Tab Contact > Chọn Business Card.  
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2 Chọn Job Title sau đó nhấn lệnh Move Field Up  

Ta thấy các dòng thông tin trên Business Card đã thay đổi 

e. Điều chỉnh tất cả trong Business Card  
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Còn một công cụ nữa trong Business Card giúp ta điều chỉnh nội dung 

thông tin. Chọn Edit Business Card trong Business Card. Trong hộp Edit 

bạn có thể thay đổi các nội dung thông tin hoặc có thể trang trí cho Business 

Card của bạn.  

 

f. Gửi Email có kèm theo Business Card  

Sau khi đã tạo ra Business Card, bạn có thể sử dụng nó để chia sẻ thông tin 

liên lạc của mình với đối tác và bạn bè. Bạn thực hiện điều đó bằng cách 

đính vào Email. Dƣới đây là một tóm tắt các bƣớc thực hiện:  

1 Từ một Email mới, bạn nhấn vào Business Card chọn Other Business 

Card.  

http://lh4.ggpht.com/_KSOH77vnC-4/SvAQxNPPkeI/AAAAAAAAAzM/MN1_X5G0vgc/image004_thumb%5B1%5D.jpg?imgmax=800
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2 Chọn Business Card từ danh sách.  

3 Business Card xuất hiện trong Email trong hộp đính kèm dƣới dạng file 

vcf. File đính kèm là ở định dạng vCard là tiêu chuẩn cho việc tạo và chia 

sẻ kinh doanh thẻ ảo trong Internet.  

 

g. Đính kèm Business Card trong phần chữ ký  
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Ngoài cách chèn Business Card vào Email bằng tay. Có một tùy chọn khác 

là chèn Business Card tự động bằng cách thêm nó vào mục chữ ký trong 

Email.  

Để Business Card nằm trong một chữ ký, bấm vào nút Business Card và 

chọn thẻ của bạn từ danh sách. Bạn có thể chọn hiển thị kích thƣớc khác 

hơn 100 phần trăm cho hình ảnh của thẻ, nhƣ đƣợc hiển thị trong hình. 
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h. Khi thay đổi Business Card – trở lại mục Contacts  
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Chúng tôi đã thảo luận của hai phƣơng pháp mà bạn có thể sử dụng để đính 

kèm của bạn Business Card đến một Email: đính kèm nó trên một Email tại 

một thời điểm bằng cách sử dụng nút Business Card, hoặc đính kèm nó vào 

Email bằng cách cho nó trong một chữ ký  

Nếu bạn thay đổi các thông tin xuất hiện trong Business Card, cần thực hiện 

các bƣớc sau:  

1 Xóa kèm file có định dạng vcf từ Email. (hoặc xóa các thẻ từ chữ ký, nếu 

bạn đã sử dụng phƣơng pháp đó).  

2 Quay trở lại mục Contacts để thực hiện sửa chữa đó 

 

i. Tạo khoảng trắng trong Business Card  
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Tab Contact > Business Card . 

Hiển thị hộp thoại Edit Business Card. 

 

Bạn có thể sử dụng khoảng trắng để tạo sự chú ý đến chi tiết quan trọng 

trong Business Card. Bởi khoản trắng sẽ tạo ra khoản cách các lĩnh vực với 

các mục quan trọng hơn. Trong một Business Card, bạn tạo khoảng trắng 

bằng cách chuyển các lĩnh vực Blank Line lên hoặc xuống. 

Chƣơng VI: Thủ thuật: 

Email, cũng giống nhƣ điện thoại, là dịch vụ đƣợc ngƣời dùng văn phòng sử 

dụng nhiều và liên tục. Dẫu rằng gửi hay đọc email là công việc hết sức đơn 

giản nhƣng thực tế thì các ứng dụng nhƣ Microsoft Outlook lại cung cấp 
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nhiều tính năng hơn so với chiếc điện thoại thông thƣờng - có những tính 

năng mà ngƣời dùng bình thƣờng không thể hiểu và khai thác. Những thủ 

thuật bên dƣới sẽ giúp bạn sử dụng Outlook hiệu quả hơn và thậm chí có 

thể thay đổi nhận định về khả năng của tiện ích email và lịch của Microsoft. 

1. Đừng lưu những gì quan trọng trong hộp thư "phế thải" 

Nhiều ngƣời dùng có thói quen sử dụng Deleted Items nhƣ một thƣ mục lƣu 

trữ thông thƣờng trong khi đây thực chất là "thùng rác" của Outlook. Nếu 

một ngày đẹp trời nào đó bạn nghĩ một khoản mục bất kỳ (email, tập tin 

đính kèm, tài liệu) có thể trở nên quan trọng thì bạn hãy khoan xóa nó. Mà 

thay vào đó, hãy lƣu chúng trong một thƣ mục khác của Outlook - bạn có 

thể tự tạo mới các thƣ mục cho từng mục đích sử dụng cụ thể. 

Cùng lúc đó, hãy nhanh tay ngăn chặn việc Outlook có thể "tống khứ" 

những khoản mục mà bạn đã thẳng tay xóa đi vài ngày trƣớc đó, nhiều khả 

năng bạn có thể khôi phục những khoản mục đã xóa. Trƣớc tiên, bạn hãy tắt 

tính năng xóa nội dung trong hộp thƣ "phế thải": trong Outlook, nhấn 

Tools.Options. Ở thẻ Other, bỏ chọn đối với mục Emty the Deleted items 

folder upon exiting. Sau đó, bạn bật tính năng AutoArchive (chọn trình đơn 

Tools.Options, chọn thẻ Other và nhấn nút AutoArchive) và thiết lập tính 

năng này tự động thực thi mỗi ngày. Kế tiếp, ở giao diện chính của Outlook, 

nhấn phải chuột lên thƣ mục (hộp thƣ) Deleted Items, chọn Properties; 

trong hộp thoại vừa xuất hiện, chọn thẻ AutoArchive và thiết lập cho thƣ 

mục này xóa sạch các khoản mục sau 5 ngày (hay một con số khác theo ý 

bạn). 

2. Thư rác – thiết lập một lần để quên hẳn 

Một nguyên tắc mà bạn cần ghi nhớ là đừng bao giờ lãng phí thời gian để 

quản lý, sắp xếp thƣ rác (spam hay junk mail). Với hầu hết ngƣời dùng, việc 

thiết lập mức High cho tính năng Junk Email Filter của Microsoft Outlook 

2003 có thể giúp lọc triệt để thƣ rác (chọn Tools.Options, ở thẻ Preferences, 

nhấn vào nút Junk Email). Sau lần đầu tiên sử dụng tính năng lọc thƣ rác ở 

mức thiết lập High, bạn hãy quay trở lại hộp thƣ Junk mail của mình sau đó 

một tuần. Nếu không phát hiện ra bất kỳ sự nhầm lẫn nào (hay nói rõ hơn là 

các thƣ quan trọng bị nhận diện thành thƣ rác) thì bạn có thể an tâm duy trì 

mức thiết lập High cho bộ lọc. Bạn nên bổ sung những địa chỉ email mà 

mình thƣờng liên lạc vào danh sách email an toàn Safe Recepients để bộ lọc 

thƣ rác "cho qua". Nếu bạn thấy có quá nhiều sự nhầm lẫn, tốt hơn hết hãy 

chuyển thiết lập về mức mặc định Low. Ngoài ra còn hai chế độ tùy chọn 

No Automatic Filtering (không lọc thƣ) và Safe Lists Only (chuyển vào 

Inbox chỉ các thƣ trong danh sách ngƣời gửi/nhận an toàn). 
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Trong mọi trƣờng hợp, đừng tốn thời gian xóa từng thƣ rác. Thay vào đó, 

hãy thiết lập tính năng tự động xóa hộp thƣ Junk Mail nhƣ hƣớng dẫn đƣợc 

trình bày trong thủ thuật 1. 

3. Gửi thư số lượng lớn với Word 

Nhiều ngƣời nghĩ rằng, tính năng trộn thƣ (mail merge) chỉ dùng để in nhãn 

cho thƣ tín. Bạn có thể đến bất kỳ thƣ mục danh bạ liên lạc nào trong 

Outlook và sử dụng lệnh Tools.Mail Merge để khởi chạy một tác vụ soạn 

email và gửi đồng loạt với tiện ích MS Word mà không cần in thƣ ra giấy. 

Thực tế cho thấy, một email cá nhân có địa chỉ ngƣời nhận cụ thể thƣờng dễ 

dàng qua mặt đƣợc các bộ lọc thƣ rác hơn email đƣợc gửi với địa chỉ ngƣời 

nhận là một địa chỉ thành phần trong mục Bcc. 

4. Tạo hộp thư tìm kiếm 

Outlook đi kèm 3 thƣ mục tìm kiếm là Follow Up, Large Email và Unread 

Mail, có khả năng hiển thị một cách tổng hợp cho toàn bộ thƣ mục trong 

hộp thƣ cá nhân. Tuy nhiên, bạn có thể tạo ra các thƣ mục tìm kiếm riêng 

bằng cách nhấn phải chuột lên thƣ mục Search Folder trong danh sách thƣ 

mục và chọn New Search Folder. 

Ví dụ, nếu đã đăng ký nhận bản tin RSS từ Microsoft Developer Network, 

bạn có thể lọc các bản tin này bằng cách tạo ra một thƣ mục tìm kiếm mang 

tên New Outlook Stuff có nhiệm vụ hiển thị đúng email chƣa đọc đƣợc gửi 

từ địa chỉ của MSDN. 

5. Sao lưu Microsoft Outlook không cần phần mềm 

 

Hiện nay, Microsoft Outlook vẫn còn rất nhiều ngƣời sử dụng vì nó 

giúp bạn quản lý nhiều tài khoản email khác nhau cùng 1 lúc. Vấn đề là 

khi bạn cài đặt lại máy tính thì việc sao lƣu nội dung Microsoft Outlook 

thƣờng rất mất thời gian và không đơn giản. Bài viết này xin trình bày 

cách sao lƣu Microsoft Outlook thủ công mà hiệu quả hơn bất kì phần 

mềm chuyên dụng nào. 

 

a. Sao lƣu tài khoản 

Cách làm nhƣ sau: Vào Start > Run > gõ regedit và bấm Enter, trong cửa 

sổ hiện ra bạn tìm đến từ khóa 

Hkey_Current_User\Software\Microsoft\Windows NT\Current 

Version\Windows Messaging Subsystem\Profiles\Outlook, bấm chuột 

http://camau-sechia.co.cc/read.php?91
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phải lên Outlook chọn Export và lƣu lại với tên Account, bấm Save để xác 

nhận (tạo ra file Account.reg). 

 

b. Sao lƣu thƣ tín đi kèm theo từng tài khoản riêng biệt 

Trƣớc tiên bạn cần công cụ Winrar, để giúp tạo ra tập tin tự chạy .exe, đây 

là công cụ nén và giải nén phổ biến nhất hiện nay,bạn có thể download tại 

đây:  

 Bây giờ, thực hiện sao lƣu thƣ tín theo từng tài khoản riêng biệt để khi 

phục hồi chính xác và rõ ràng, bạn vào My Computer > Local Disk C > 

Documents and Settings >Tài khoản bạn đang sử dụng > Local Settings 

> Application Data > Microsoft > Outlook (lƣu ý: thƣ mục Local 

Settings là thƣ mục ẩn không nhìn thấy đƣợc, muốn nó hiện ra bạn phải cho 

windows hiển thị thƣ mục và tập tin ẩn bằng cách nhấp đôi vào My 

Computer > chọn Tools trên thanh công cụ > Folder Options > View > 

đánh dấu chọn mục Show hidden files anh folders > bấm OK để xác 

nhận). Trong thƣ mục Outlook có 2 files tên là Outlook.pst chuyên chứa 

nội dung các thƣ tín và Archive.pst chứa các lênh phân phối từng lá thƣ 

theo từng tài khoản khác nhau. Trƣớc tiên, bạn bấm chuột phải lên file 

Archive.pst rồi chọn lệnh Add to archive, trong bảng Archiving Options 

bạn đánh dấu chọn mục Create SFX archive, mở thẻ Advanced rồi bấm 

SFX options. Trong dòng Path to extract có 1 khung để điền đƣờng dẫn, 

bạn hãy điền chính xác đƣờng dẫn đến file Archive.pst, bấm OK để xác 

nhận cài đặt. 

Làm tƣơng tự với file Outlook.pst để tạo ra 2 file tự chạy với tên 

Outlook.exe và Archive.exe. Đây là 2 files giúp bạn phục hồi chính xác nội 

dung lá thƣ và thông tin tài khoản gửi thƣ. 

 

c. Sao lƣu chữ ký, mật khẩu, rule và tất cả 

Cách làm nhƣ sau: tìm đến thƣ mục My Computer > Local Disk C > 

Documents and Settings > Tài khoản bạn đang sử dụng > Application 

Data, trong này có 1 thƣ mục tên là Microsoft, bấm chuột phải lên thƣ mục 

này và chọn Add to archive và làm tƣơng tự nhƣ trên để tạo ra file tự chạy 

có tên là Microsoft.exe. File này giúp bạn phục hồi các chữ ký, mật khẩu, 

các quy tắc khi gửi thƣ, lịch biểu, sổ địa chỉ, các giao diện, mật khẩu bảo vệ 

thƣ,.... 
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d. Phục hồi nguyên vẹn Microsoft Outlook 

Bây giờ bạn đem các files Account.reg, Outlook.exe, Archive.exe, 

Micrsoft.exe lƣu vào 1 nơi an toàn. Sau khi cài đặt lại máy, bạn lần lƣợt 

chại các file này để phục hồi lại Microsoft Outlook nguyên vẹn nhƣ ban 

đầu. 

 

6. Skylook 2.0  

Skylook là phần mở rộng của Microsoft Outlook. Khi cài đặt Skylook sẽ tạo 

một toolbar của Skype trên giao diện của Outlook, cho phép thực hiện các 

cuộc gọi cũng nhƣ ghi âm từ Skype.  

 

 

 

 

 

7. Cấu hình tài khoản gmail 

 

Nếu bạn đang sử dụng bộ Office của Microsoft có công cụ MS Outlook thì 

hãy tận dụng nó để duyệt và quản lý hộp thƣ của Google nhanh chóng hơn. 
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Trƣớc hết, bạn phải đăng nhập vào hộp thƣ Gmail tại trang 

http://mail.google.com, rồi vào Settings > chọn thẻ Forwarding and 

POP/IMAP > đánh dấu chọn vào trƣớc dòng Enable POP for all mail or 

Enable POP for mail that arrives from now on trong mục POP Download. 

Xong, nhấn Save Changes. 

 

Sau đó, bạn mở MS Outlook lên.  

 

Thêm một tài khoản e-mail trong Outlook 

Nhấp vào tab File. 

Trên tab Info, theo Account Information, nhấp vào Account Settings. 
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Nhấp vào Add Account. 

Nhập tên, Địa chỉ email của bạn, và mật khẩu của bạn. 

 

 

Nhấn Next 



Phiên bản thử nghiệm – Lưu hành nội bộ - Microsoft Vietnam 

 

145 

 

 

 

Nhấn Finish. 

 

 

8. Mở Calendar, Contacts hay Task List cùng lúc 
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Phải di chuyển chuột quá nhiều lần mỗi khi cần hoán đổi giữa Inbox và 

Calendar, hay Contacts và Tasks? Hãy nhấn chuột phải vào một trong 

những nút này và chọn Open in a New Window, bạn sẽ giữ đƣợc Contacts 

và Calendar đƣợc mở ở 2 cửa sổ riêng biệt. Các cửa sổ này vẫn mở ngay cả 

khi đọc thƣ, dùng tổ hợp Alt-Tab để di chuyển giữa các cửa sổ. 

  

9. Hiển thị ngày tháng ở Calendar 

  

Ngƣời dùng có thể chọn hiển thị nhiều ngày tháng cùng lúc, với các ngày 

liền kề hoặc không bằng cách giữ Ctrl và chọn những ngày tháng muốn 

xem ở góc trên cùng bên trái của cửa sổ Calendar. Các ngày tháng đã nhấn 

chọn sẽ xuất hiện dƣới dạng cột ở phần hiển thị chính của Calendar. Ngƣời 

dùng cũng có thể hiển thị nhiều ngày liên tục bằng cách giữ chuột và kéo để 

chọn các ô này. 

  

  

10. Sử dụng ký tự viết tắt cho ngày, giờ 

  

Calendar của Outlook có thể hiểu cả văn bản tiếng Anh dạng cơ bản lẫn 

những chữ viết tắt trong phần Start Time và End Time. Ví dụ nhƣ, thay vì 

gõ hẳn ngày tháng chỉ cần gõ “next Tue” hoặc “next month”, Calendar sẽ tự 

động chèn ngày chính xác. (“Next month” tính theo ngày cách ngày hôm 

nay 1 tháng.) Trong trƣờng thời gian, ngƣời dùng có thể gõ “now” hoặc viết 

tắt nhƣ “4p”, Outlook sẽ chỉnh lại là “4:00 pm.” Tƣơng tự, các ký tự viết tắt 

http://vatgia.com/raovat/3552/tieng-anh.html
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dạng cơ bản cũng có thể sử dụng với cửa sổ Scheduling, ngƣời dùng có thể 

mở hộp thoại Appointment Recurrence và nhập “next Thursday” vào phần 

Start, Outlook sẽ trả về ngày chính xác. 

  

11. Tùy biến thanh Ribbon 

Lần đầu xuất hiện trong bản Office 2007, thanh công cụ với giao diện 

Ribbon sớm trở thành chủ đề tranh cãi giữa ngƣời dùng. Một số ngƣời dùng 

rất ƣa thích giao diện Ribbon mới này, trong khi số khác lại cho rằng giao 

diện menu cũ tiện lợi hơn. Bởi vậy các nhà phát triển thứ ba đã ngay lập tức 

cho ra mắt những chƣơng trình có khả năng trả về giao diện menu cũ quen 

thuộc, ví dụ nhƣ Classic Menu từ Addintools. 

Thanh Ribbon vẫn tiếp tục xuất hiện trong phiên bản Office 2010 này, thậm 

chí nó đã đƣợc bổ sung vào tất cả các ứng dụng của bộ Office bao gồm cả 

Outlook và OneNote. Tuy nhiên, khác biệt lớn nhất so với phiên bản trƣớc 

chính là việc bạn có khả năng tùy biến thanh Ribbon. Bạn có thể quyết định 

xem tính năng nào đƣợc xuất hiện trên mỗi tab, thậm chí nếu muốn, bạn 

hoàn toàn có thể thêm đƣợc tab mới và đặt những tính năng ƣa dùng lên tab 

đó. 

Để tùy biến thanh Ribbon, bạn click chuột phải vào nó, chọn Customize 

The Ribbon. Trong hộp thoại mới hiện ra, bạn có thể tự do tạo tab mới 

hoặc thêm / bớt tính năng trên mỗi tab. 

http://www.addintools.com/english/menuoffice/
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12. Thêm dữ liệu lịch biểu vào email 

  

Nếu email đang sử dụng thuộc server Microsoft Exchange và cần gửi thƣ 

cho một ai đó cũng thuộc Exchange, ngƣời dùng có thể thêm dữ liệu từ lịch 

vào email. Trong cửa sổ soạn thảo thƣ, chọn trong dải Message (mặc định), 

chọn Calendar từ nhóm Include và chỉ định khoảng thời gian, mức độ chi 

tiết. Tùy chọn này không có sẵn nếu tài khoản ngƣời dùng thuộc server POP 

hoặc IMAP. 

  

13. Bỏ các add-in không cần thiết 

  

http://vatgia.com/846/server-may-chu.html
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Có thể giúp Outlook 2010 chạy nhanh và êm ái hơn bằng cách bỏ các add-

in mà các phần mềm khác đã cài đặt vào. Chọn File . Options… click chọn 

Add-ins, chọn Manage (mục ở dƣới cùng), phải đảm bảo COM Add-in là 

các mục hiện hành, nhấn Go…. Từ hộp thoại COM Add-in ngƣời dùng có 

thể vô hiệu hóa các mục bằng cách bỏ đánh dấu hoặc click chọn Remove để 

loại bỏ hoàn toàn. 

 

14. Các phím tắt 

Các phím tắt sử dụng trong  Microsoft Outlook. 

- Ctrl+1: mở cửa sổ Mail. 

- Ctrl+2: mở Calendar. 

- Ctrl+3: mở Contacts. 

- Ctrl+4: mở Tasks. 

http://vatgia.com/476/phan-mem.html
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- Ctrl+5: mở Notes. 

- Ctrl+Shift+M: tạo tin nhắn mới trong Outlook. 

- Ctrl+Shift+C: tạo liên lạc (Contact) mới. 

- Ctrl+N: soạn tin nhắn mới. 

- Ctrl+R: trả lời tin nhắn. 

15. Kéo và thả bất cứ thứ gì 

Một trong những ƣu điểm lớn nhất trong Outlook là bạn có thể kéo và thả 

bất cứ mục Outlook nào từ một thƣ mục này sang thƣ mục khác. Kéo một 

email vào thƣ mục các liên lạc của bạn, khi đó Outlook sẽ tạo một liên lạc 

cho bạn bằng first name và last name và địa chỉ email cho bạn. Kéo email 

vào thƣ mục lịch biểu, lúc này một cuộc hẹn sẽ đƣợc tạo ra cho bạn với các 

lƣu ý của lịch biểu là phần body của email đƣợc nhập vào. 

16. Kích phải bất cứ thứ gì 

Nếu bạn nghi ngờ và không muốn biết những gì cần thực hiện tiếp theo 

trong Outlook, chỉ cần kích phải vào một mục Outlook nào đó, khi đó menu 

sẽ xuất hiện và cung cấp cho bạn tính năng mong muốn. Kích phải vào tên 

trong địa chỉ email và chọn Add to Outlook Contact, khi đó liên lạc của bạn 

sẽ đƣợc tạo một cách tự động. Kích phải vào mục calendar, bạn có thể in nó 

và đem mang theo nó kèm bạn đến cuộc hẹn. 

17. Tìm kiếm mọi thứ 

Nếu bạn giống nhƣ chúng tôi, đợi một vài giây để tìm kiếm thứ nào đó có 

thể phát bực dọc thì một trong những tính năng tốt nhất mà chúng tôi thích 

trong Outlook 2010 là có thể tìm kiếm nhiều thứ nhanh hơn nhiều. Chỉ bản 

thân bộ tìm kiếm này cũng quả đáng nâng cấp nếu bạn vẫn đang sử dụng 

phiên bản Outlook cũ. Chỉ cần đánh vào bất cứ một từ nào trong hộp thoại 

Search trong Inbox của bạn hay bất cứ thƣ mục mail nào, Outlook khi đó sẽ 

tìm ra cho bạn email cần thiết. Bạn có thể thực hiện tƣơng tự với các mục 

Contacts, Calendar hay Task. Hộp thoại tìm kiếm nằm phía trên bên trái của 

cửa sổ và sẽ nhanh chóng trả về kết quả tìm kiếm cho bạn. Cho ví dụ, trong 

thƣ mục Contact của bạn, chỉ cần đánh New York và tất cả các liên lạc của 

bạn có địa chỉ New York hoặc các lƣu ý nào có ghi New York sẽ đƣợc hiện 

ra. 
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18. Tạo các thư mục mở cho bất cứ thứ gì 

Một số trong số các bạn chắc hẳn đã biết đƣợc cách tạo các thƣ mục email 

mở rộng bằng cách kích phải vào danh sách thƣ mục và chọn New Folder. 

Bạn có biết mình có thể tạo các kiểu thƣ mục khác nhƣ các liên lạc khác, 

lịch biểu hoặc thƣ mục nhiệm vụ không? Để tạo thƣ mục Contact khác, có 

lẽ chỉ một liên lạc cá nhân nào đó, bạn kích phải vào bất cứ thƣ mục nào và 

chọn New Folder. Dƣới "Folder Contains," chọn Contact Items và chọn địa 

điểm bạn muốn lƣu New Contact Folder, sau đó thƣ mục bạn vừa tạo sẽ 

hiện hữu ở đó. 

19. Tiết kiệm thời gian thời gian, chỉ Download tiêu đề của Email  

Chạy Outlook 2010 offline có thể có ích nếu bạn muốn thực hiện các nhiệm 

vụ khác ngoài email. Nhƣng nếu bạn có 100 email và muốn tải chúng về 

máy của mình. Theo mặc định Outlook 2010 tải cả các email và các tập tin 

đính kèm và không yêu cầu ngƣời sử dụng về cài đặt này khi thiết lập một 

tài khoản cho lần đầu tiên.  

Trong Outlook 2010 bạn có thể nhấn Ctrl + Alt + S để mở Outlook của bạn 

Gửi và nhận Groups, nhƣng đây không phải là trƣờng hợp trong Outlook 

2010.Trƣớc tiên, bạn click vào Send/Receive tab -> Send/Receive Groups -

> Define Send/Receive Groups đƣợc thể hiện trong hình dƣới đây 

 

 

Hộp thoại Send/Receive Groups hiển thị. Nhấn vào nút Edit. 
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Now under the Account Options, select „Download headers for subscribed 

folders‟. This will download your emails faster by ignoring the attachments. 

This can be a quick way to send/receive emails and save time. 

Bây giờ bên dƣới mục Account Options, chọn “Download headers for 

subscribed folders”. Khi chọn mục này outlook 2010 sẽ tải về các email của 

bạn nhanh hơn bằng cách bỏ qua các tập tin đính kèm. Việc chọn này nhanh 

chóng để gửi / nhận email và tiết kiệm thời gian. 
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